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Forord 

Denne oppgaven er levert inn som det avsluttende arbeidet på sivilingeniørgraden Vann- og 

miljøteknikk ved Norges miljø- og biovitenskapelige universitet. Oppgavens omfang er 30 

studiepoeng og arbeidet har pågått våren 2017.  

Målsetningen med oppgaven har vært å finne en metodikk for å anvende nedbørdata fra 

værradar i en todimensjonal hydraulisk avrenningsmodell, og å studere værradardatas egnethet 

i en slik modell. Det er tatt utgangspunkt i et analyseområde i Drammen sentrum og en ekstrem 

nedbørhendelse sommeren 2015. Programvaren benyttet er MIKE 21 levert av DHI. 

Vi ønsker å takke vår veileder Jon Arne Engan for godt samarbeid og konstruktive 

tilbakemeldinger underveis i prosessen. Takk til Halvor Hardang og de øvrige medarbeiderne 

ved DHI Oslo for hjelp til å bygge avrenningsmodellen og optimalisering av simuleringene. 

Takk til Christoffer A. Elo ved Meteorologisk Institutt for leverte værradardata og anvendelse 

av disse. Vi ønsker også å takke vår arbeidsgiver Norconsult AS for lån av datamaskiner.  

Tilslutt ønsker vi å rekke en stor takk til SINTEF og KS for økonomiske midler til 

gjennomføringen av oppgaven.  
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Sammendrag 

Ekstreme nedbørhendelser med påfølgende pluviale flommer forårsaker store skader på 

infrastruktur og bebyggelse. Skadene fører til betydelige samfunnskostnader, og problemet er 

økende. Avrenningsmodeller kan benyttes for å simulere flomforløpet til en nedbørhendelse, 

og er et mye brukt verktøy i planlegging, prosjektering, dimensjonering og drift av overvann-

systemer. Som inngangsdata i avrenningsmodeller er det vanlig å bruke konstruert nedbør, der 

det tas utgangspunkt i målinger og statistikk fra nedbørstasjoner basert på lange tidsserier. I 

denne oppgaven er det undersøkt om inngangsdata fra værradar kan gi et mer realistisk bilde 

på hvordan pluviale flommer forløper.  

Oppgavens primære målsetning har vært å finne en metodikk for å benytte data fra værradar i 

en todimensjonal hydraulisk avrenningsmodell. Det var ønskelig å finne en metode der rådata 

fra værradaren kunne anvendes direkte i avrenningsmodellen med den oppløsningen i rom og 

tid de var målt. Dette ble løst ved å bygge en terrengmodell i ustrukturerte trekanter. En slik 

modell tillater, i motsetning til en terrengmodell på rasterformat, at inngangsdata med ulik 

romlig oppløsning kan benyttes sammen. Programvare for bygging av terrengmodell og 

simulering av avrenning er MIKE 21 Flow Model FM levert av DHI.  

For å kunne si noe om egnetheten til data fra værradar i en avrenningsmodell er nedbørdata fra 

værradar sammenlignet mot data fra nedbørstasjoner på bakkenivå. Studiet tar utgangspunkt i 

en nedbørhendelse i Drammen sentrum den 11. juli 2016 i tidsintervallet 12.30–15.40. 

Nedbørhendelsen var av konvektiv karakter, en nedbørtype som karakteriseres ved høy 

intensitet, kort varighet og store lokale variasjoner. Resultatene viser at værradaren 

underestimerer nedbøren for alle intensiteter, og at feilen er økende med økende intensitet. 

Feilen skyldes i all hovedsak konverteringen av målt radarreflektivitet til nedbørintensitet, samt 

signaldemping fra annen nedbør mellom radaren og studert nedbørhendelse. Det er benyttet to 

ulike metoder for å korrigere for feilen i nedbørdataene fra værradaren. Et datasett er korrigert 

mot syv nedbørstasjoner i Drammen sentrum, heretter kalt korrigert nedbør, og et datasett er 

basert på én nedbørstasjon som ligger innenfor nedbørfeltet til avrenningsmodellen, heretter 

kalt lokalkorrigert nedbør. Resultater fra simuleringene viser at valg av korreksjonsmetode har 

stor innvirkning på avrenningen. Det ble også benyttet en konstruert regnhendelse med 

tilsvarende intensitet som de korrigerte værradardataene i modellen. Resultatene fra denne 

sammenligningen viste ingen nevneverdige ulikheter. 



IV 

 

Det er produsert gjentaksintervallkart med varighet på 10 og 40 minutter for korrigerte nedbør 

fra værradar. Kartene viser betydelige variasjoner i gjentaksintervall innad i analyseområdet, 

og belyser verdien av den romlige oppløsningen en værradar kan tilføre nedbørdata. 

Gjentaksintervallkartene er også sammenlignet mot interpolert gjentaksintervallkart basert på 

nedbørstasjonene. Sammenligningen viser at nedbørstasjonene ikke fanger opp hendelsens 

mest nedbørrike områder og videre underestimerer hendelsens omfang.  

På bakgrunn av resultatene i oppgaven er det diskutert om værradar kan benyttes til varsling 

av pluviale flommer. For at dette skal bli en realitet må værradardataenes kvantitative kvalitet 

forbedres samtidig som modellenes simuleringstid må reduseres til en tidsramme som gjør det 

mulig å iverksette tiltak. 
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Abstract 

Extreme rainfall events with subsequent pluvial floods cause great damage to infrastructure 

and buildings. Flood damage is a heavy cost to society, and the problem is increasing due to 

climate changes and urbanization. Pluvial flooding is often simulated using a runoff model, a 

helpful tool for designing, dimensioning and operating storm water systems. Traditionally, 

measurements from rain gauges are used to produce design storms for input in the runoff 

models. Heavy precipitation often occurs with a high spatial variation and over a short period 

of time. This thesis aims to see whether the input data from weather radars, with its high spatial 

and temporal variability, can provide a more realistic picture of how pluvial floods progress.  

The thesis’ primary purpose has been to find a methodology for applying weather radar data in 

a two-dimensional hydraulic runoff model, using the data’s original spatial and temporal 

resolution. To achieve this, the model was set up with a digital terrain model built up of small, 

unstructured triangles in a flexible mesh. In contrast to the classic approach, a structured 

orthogonal mesh, the flexible mesh allows for an increase of the mesh resolution and allows 

layers with different resolutions to be used together. The modelling software used in the study 

was MIKE 21 Flow model FM, delivered by DHI. 

To analyze radar data’s suitability in runoff models, the radar data has been compared to 

precipitation data from seven rain gauges. The study is based on an event in the city of 

Drammen, July 11 2016. This was a convective rainfall, which is characterized by high 

intensity, short duration and high spatial variability. The results show that the weather radar 

underestimates the precipitation for all intensities, and that the bias increases with increased 

intensity. The error is due to the converting of radar reflectivity to precipitation intensity and 

attenuation of the radar signal from precipitation between the studied rainfall event and the 

radar station. To increase the quantitative quality, the radar data was adjusted towards the 

observed values at the gauging stations.  

Two different adjusted radar datasets were used in the simulations. One dataset was corrected 

using measurements from all seven gauging stations, while the other was adjusted using data 

from only one station, located within the modeling area. The result shows that the choice of 

adjusting method is of great importance for the runoff, as the use of the latter method gives less 

runoff compared to the first method. The radar simulations were also compared to a simulation 

of a design storm with the same intensity as the radar dataset adjusted to the seven gauging 

stations. The comparison showed no significant differences.  
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Maps of the return periods for the most intense 10 and 40 minutes of the adjusted rainfall event 

were produced and compared to the return periods at the gauging stations. The maps show 

significant variations within the small area analyzed. The gauging stations fail to catch the most 

intense rainfall cells, and the maps clearly illustrates the uncertainties in using point 

measurements when characterizing convective rainfall events. 

The weather radar data’s spatial and temporal resolution is well suited for use in runoff models. 

For these models to become useful in forecasting of pluvial floods, the quantitative quality of 

the rainfall data must be improved, and the computation time of the simulations must be 

reduced.  
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1 Innledning 

Klimaendringer medfører endringer i nedbørsmønsteret i Norge. Det blir mer nedbør og mer 

intens nedbør. Styrtregn, kraftig regn, regnflom og ekstremnedbør er ulike begrep som brukes 

til å beskrive fenomenet der store nedbørmengder kommer over kort tid. Denne typen hendelser 

er ofte forårsaket av konvektiv nedbør, der nedbøren er et resultat av hurtig oppvarmning av 

lufta over bakken. Konvektiv nedbør er et typisk sommerfenomen og oppstår ofte svært lokalt, 

der nedbørmengde og intensitet på to lokasjoner med kort avstand kan avvike i stor grad.  

Klimaendringer gir sammen med økt urbanisering store utfordringer med overvann.  Overvann 

er en samlebetegnelse på nedbør, smeltevann og stormflo som renner av på tette overflater. 

Dersom kapasiteten på ledningssystem som skal lede overvannet til resipienter og naturlig 

infiltrasjon overskrides oppstår pluvial flom. Begrepet pluvial flom brukes om flom i urbane 

strøk, og skiller seg fra fluvial flom ved at hendelsene forårsakes av nedbør med varighet fra 

noen minutter opptil få timer. Fluvial flom, flom der et vassdrag går over sine bredder, skyldes 

ofte nedbørhendelser med varighet opptil flere døgn og faller gjerne sammen med snøsmelting. 

Tradisjonelt er flombegrepet i Norge knyttet til det sistnevnte fenomenet, men de senere årene 

har hendelser med ekstremnedbør i tettbebygde og urbane strøk økt fokuset på, og 

nødvendigheten for å forstå pluviale flommer. Eksempel på slike hendelser fant sted i 

København 2. juli 2011 og Oslo 6. august 2016.   

Erstatningsutbetalinger for vannskader i forbindelse med pluvial flom har økt kraftig og er nå 

høyere enn beløpet som utbetales for hendelser forårsaket av fluvial flom (Finans Norge 2016). 

Det anslås at de totale skadekostnadene som oppstår som følge av overvann er i størrelsesorden 

1,6 til 3,6 milliarder kroner per år (NOU 2015:16). Skadene rammer både innbyggere, 

kommuner, veieiere og forsikringsselskaper. Klimaframskrivinger tilsier at denne typen 

hendelser vil øke i omfang og hyppighet, og myndigheter og kommuners fokus på å tilpasse 

infrastruktur og fremtidig byplanlegging er økende.  

Som et verktøy for å kunne predikere flomstørrelse og omfang er det er utviklet databaserte 

modeller som simulerer overvannets bevegelser på overflaten. Slike modeller er i beste fall en 

tilnærming av virkeligheten, men de kan gi gode indikasjoner på hvor vannet vil akkumuleres 

og strømme under en flomepisode. Modellene kan dermed bidra til å redusere risiko og 

skadeomfang forårsaket av ekstremnedbør. Det tas ofte utgangspunkt i konstruerte 

regnepisoder basert på punktmålinger fra nedbørstasjoner og statistikk fra disse. De konstruerte 

episodene har god oppløsning i tid, men ingen romlig oppløsning, slik at det til enhver tid vil 
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regne like mye alle steder i modellområdet. Siden konvektive byger er karakterisert ved store 

lokale variasjoner i nedbørintensitet vil et konstruert regn skille seg betydelig fra virkeligheten 

og utgjøre en signifikant usikkerhet i modellen.  

En værradar kan registrere nedbør med et høyt detaljnivå i rom og tid. Værradaren måler 

reflektivitet i en høyde som avhenger av radarens avstand fra nedbøren. Reflektiviteten gjøres 

videre om til nedbør på bakkenivå, og det er i den forbindelse knyttet usikkerhet til den 

kvantitative kvaliteten på radardataene. Usikkerheten kan reduseres ved at radardataene 

korrigeres mot målinger fra nedbørstasjoner. Radardata benyttes i dag som inngangsdata i 

Meteorologisk institutts værvarslingsmodeller og til dels i hydrologiske modeller for beregning 

av avrenning fra nedbør og snøsmelting i vannkraftbransjen. Det er så vidt forfatterne bekjent 

ikke tidligere brukt nedbørdata fra værradar i todimensjonale hydrauliske avrenningsmodeller 

til beregning av pluviale flommer. 

1.1 Problemstilling 

Formålet med denne oppgaven å finne en metodikk for å benytte nedbørdata fra værradar i en 

todimensjonal hydraulisk avrenningsmodell, og undersøke om dette kan gi et mer realistisk 

bilde på hvordan pluviale flommer forløper. For å kunne si noe om dette er det nødvendig å 

studere kvaliteten på nedbørdata fra værradar, og egnetheten til disse i denne type modeller. 

Oppsummert er problemstilling og spørsmål som ønskes besvart i denne oppgaven: 

o Hvordan skiller nedbørdata fra værradar seg fra data fra nedbørstasjoner, og hvordan 

kan de kombineres for å gi en best mulig fremstilling av virkeligheten?   

o Hvordan kan nedbørdata fra værradar benyttes i en avrenningsmodell? 

o Hvordan egner værradardata seg som inngangsdata i en avrenningsmodell? 

o Kan værradar benyttes til varsling av pluviale flommer? 
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1.2 Fremgangsmåte og struktur 

Oppgaven består av syv hovedkapitler. Kapittel 2 Bakgrunn er resultatet av litteraturstudie på 

teori med relevans for oppgaven. I Kapittel 3 fremlegges metode for prosessering og 

anvendelse av nedbørdata i oppgaven. Kapitlet inneholder også en beskrivelse av 

avrenningsmodellens oppbygning og oppsett ved simulering, samt forutsetninger og antakelser 

som ble gjort for å komme frem til resultatene presentert i kapittel 4. I Kapittel 5 diskuteres 

oppgavens resultater, metode og usikkerheter og det legges frem et forslag til videre arbeid. Til 

slutt konkluderes oppgaven på bakgrunn av problemstilling og resultat. 
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2 Bakgrunn  

2.1 Klimaendringer  

Klima er definert som vær over tid, og beskrives ofte ved bruk av maksimum-, minimum- og 

middelverdier (Dannevig & Harstveit 2017). Det som skiller vær og klima er tidsbegrepet; vær 

beskriver forholdene i atmosfæren over en kort tidsperiode mens klima beskriver hvordan 

forholdene endres over en lengre tidsperiode. For at observasjoner av vær og klima skal kunne 

sammenlignes opererer man med normalperioder for klima på 30 år. Gjeldende normalperiode 

er 1961-1990, men perioden 1971-2000 brukes også til sammenligning i en del nyere forskning.  

I Norge er klimaet mildere enn breddegraden tilsier, noe som skyldes et samspill mellom den 

varme Golfstrømmen, sørlige lavtrykk og fuktig luft med nedbør. Klimaet innad i landet 

varierer i stor grad, avhengig av geografi og sesong. Høye fjellkjeder mellom øst og vest i sør 

bidrar til et værskille der vestavinden gir mye nedbør på Vestlandet mens Østlandet har et 

kontinentalt og tørt klima. Nord-Norge preges også av et fuktig klima langs kysten og tørrere 

klima i innlandet. Generelt er det minst nedbør på senvinteren og våren og mest nedbør på 

høsten. I områdene rundt Oslofjorden er vintrene relativt milde og nedbørfattige, mens det er 

kjøligere i lavtliggende indre deler av området. Somrene er preget av relativt høye temperaturer 

og tidvis intense nedbørperioder. Disse områdene har landets høyeste dimensjonerende 

nedbørverdier for kortvarige, intense regnskyll (Norsk Klimaservicesenter 2017c). De siste 

hundre årene har man sett betydelige endringer i klimaet, både i Norge og globalt (NOU 

2015:16). Klimaendringer anses som en av vår tids største utfordringer.  

Med klimaendring menes en varig endring i klimaet og begrepet skilles fra klimavariasjon som 

omfatter endringer med kortere varighet (Fuglestvedt et al. 2017). Klimaet har alltid vært i 

endring, da innstrålingen fra solen, refleksjonen av solstråling til verdensrommet og utstråling 

fra jorden og atmosfæren varierer (Hanssen-Bauer et al. 2015). Klimaendringene de siste par 

hundre årene skiller seg fra tidligere ved at endringene har vært særlig kraftige og raske (Alfsen 

2001). En akseptert teori forklarer endringene med den betydelige økte konsentrasjonen av 

klimagasser i atmosfæren. Endringene anses å være en kombinasjon av både naturlige og 

menneskeskapte årsaker (Butler & Davies 2010), men FNs klimapanel hevder i sin rapport 

(IPPC 2013) at det er svært sannsynlig at den observerte globale oppvarmingen hovedsakelig 

skyldes menneskelig aktivitet. Forbrenning av kull, olje og gass slipper ut klimagasser som 

samler seg opp i atmosfæren og fører til at netto innstråling øker og den naturlige 

drivhuseffekten forsterkes. Dette har videre gitt en økning i temperaturen på jordoverflaten. 
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Mellom 1880 og 2012 steg den globale temperaturen med 0,85℃ (IPPC 2013). 

Temperaturøkningen har ført til at gjennomsnittlig årlig nedbør i Norge har økt med 18% siden 

1900 (NOU 2015:16). Økningen har vært størst de siste 30 årene, som vist i Figur 2-1. De 

fremtidige endringene er ventet å være enda større enn de observerte. 

 

Figur 2-1: Utvikling av årsnedbør for Fastlands-Norge i perioden 1900- 2014. Søylene viser avvik (%) fra middelverdien i 

normalperiode 1971-2000, og kurven viser årsverdiene glattet ut for å se langtidsvariasjonene. Hentet fra Hanssen-Bauer et 

al. (2015). 

Med utgangspunkt i forskjellige antakelser om utslipp av klimagasser har FNs klimapanel, ved 

hjelp av avanserte modeller og kunnskap om historisk klima, beskrevet forestående global 

klimautvikling. Fremtidig naturlig klimavariasjon, manglende kunnskap om klimasystemets 

følsomhet og begrensninger i modellen gjør at beregningene er beheftet med stor usikkerhet. 

Modellene gir likevel en god indikasjon på hvordan klimaendringene vil utarte seg. 

Usikkerheten knyttet til menneskeskapte utslipp kompenseres ved at en simulerer ulike 

utslippsscenarioer. De globale modellene har ofte for lav romlig oppløsning til å kunne brukes 

direkte til å vurdere regionale og lokale konsekvenser av endringene. Det er derfor nødvendig 

å nedskalere resultatene fra modellen. Et høyt utslippsscenario tilsvarer at de globale 

klimagassutslippene fortsetter å øke som i de siste tiårene. For dette scenarioet anslås det at 

årsmiddeltemperaturen i Norge vil øke med mellom 3,3 og 6,4 ℃ frem mot 2100, avhengig av 

region (Hanssen-Bauer et al. 2015). Beregningene viser videre at det blir mer nedbør i hele 

landet. Både årsnedbør, antall dager med kraftig nedbør og nedbørmengden på dager med 

kraftig nedbør ventes å øke. For et høyt utslippsscenario ventes middelnedbøren å øke mellom 
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5-20 prosent frem mot 2100, med størst økning i sørvest og nord. Videre ventes det en dobling 

av dager med kraftig nedbør og en økt nedbørmengde på dager med kraftig nedbør på 19 

prosent (Hanssen-Bauer et al. 2015). Det antydes også en økning i intens nedbør med varighet 

på noen få timer. Hanssen-Bauer et al. (2015) anslår at et tretimersnedbør med fem års 

gjentaksintervall vil øke med 30 prosent i snitt gitt høyt utslippsscenario, og økningen kan bli 

enda større for høyere gjentaksintervall. For korttidsnedbør foreligger det i dag et begrenset 

datagrunnlag. Måleseriene er korte og nedbørstasjonstettheten er for lav til å fange opp de mest 

intense konvektive bygene.  Følgelig vil framskrivningene knyttet til denne type nedbør være 

beheftet med en større grad av usikkerhet (Førland et al. 2015). 

Klimaendringer i form av høye temperaturer, mer nedbør og mer intense nedbørepisoder får 

direkte virkning på avrenning og flommer. Det er ventet at klimaendringene vil endre 

flomregimet i Norge i fremtiden. Snøsmelteflommene vil komme tidligere på året og vil avta 

mot slutten av århundret samtidig som pluviale flommer vil øke i størrelse og omfang og etter 

hvert dominere helt (Norsk Klimaservicesenter 2017b). De største skadene oppstår gjerne i 

bynære strøk der tette flater som asfalterte veier og parkeringsplasser dominerer og gir raskere 

avrenning enn naturlige flater. Hvordan urbanisering påvirker et steds hydrologi har dermed 

stor betydning for dannelse og utvikling av pluviale flommer.  

2.2 Urbanisering 

Hydrologi er vitenskapen om vannets forekomst, egenskaper, kretsløp og vekselvirkning med 

omgivelsene (Thorolfsson 2014).Vannets kretsløp representerer en konstant sirkulasjon 

mellom de ulike reservoarene på jorden og kan beskrives av vannbalanseligningen   

 

𝑃 = 𝑅 + 𝐸 +  ∆𝑆  
 

(1) 

der 𝑃 er nedbør, 𝑅 er avrenning både på overflate og i grunnen, 𝐸 er evapotranspirasjon og ∆𝑆 

er vann som er lagret i løpet av en tidsperiode. Den delen av det hydrologiske kretsløpet som 

omfatter bebygde områder defineres som urbanhydrologi (Thorolfsson 2014).  

Byutvikling har en stor innvirkning på forholdet mellom de ulike prosessene i det hydrologiske 

kretsløpet i området. For å kunne si noe om problemene knyttet til overvann, er det viktig å 

forstå effekten av urbanisering. Når regn faller på uberørte områder vil noe av vannet infiltreres 

i bakken, noe vil returneres til atmosfæren gjennom evaporasjon og noe transpireres av planter. 

Bare en liten andel vil renne av på overflaten. Forholdet mellom disse vil avhenge av 

overflatens egenskaper og varierer med tid (Butler & Davies 2010). Utbygging av byer og 
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tettsteder innebærer at naturlige flater erstattes med kunstige flater. Disse flatene er i stor grad 

impermeable og har en stor effekt på prosessene i vannbalansen. Veier, parkeringsplasser og 

takbelegg øker mengden overflateavrenning i forhold til infiltrasjon slik at det totale 

vannvolumet som renner av på flatene øker.  Likeledes vil konsentrasjonstiden, tiden en 

regndråpe bruker fra den faller i ytterkant av feltet til den når fram til utløpet, avta. Dette gjør 

at det tar kortere tid før hele feltet bidrar til avrenning. Overflatevannet vil dessuten renne 

hurtigere av på harde flater og i avløpsnettet enn på naturlige flater, slik at avrenningstoppen 

blir større og opptrer tidligere. Dette er illustrert i Figur 2-2. Når mindre vann infiltreres i 

bakken vil grunnvannsstanden senkes, noe som blant annet kan gi store setningsskader på 

bebyggelse og infrastruktur. En annen følge av urbanisering er økt forurensning av 

overflatevannet. Veier og andre tette flater samler opp tungmetaller og andre organiske 

miljøgifter i tørrværsperioder som vaskes ut sammen med overvannet ved nedbørhendelser. 

Store mengder av det forurensede vannet slippes ut i naturen, men mengdene kan begrenses 

ved bruk av rensedammer og andre åpne overvannsløsninger. 

 

Figur 2-2: Effekten av urbanisering på avrenning. Tilpasset fra SINTEF Byggforsk (2012). 

Befolkningsveksten i Norge har vært jevnt stigende de siste hundre årene. Endringer i 

næringsstruktur og sentralisering har ført til at stadig flere ønsker å bosette seg i tilknytning til 

de store byene. Befolkningsøkningen påvirker behovet for by- og tettstedsutvikling som ofte 

innebærer en fortetting med et stort press på de grønne arealene. I en undersøkelse utført av 

Vista Analyse (2015) kommer det frem at om lag 20 prosent av grønnstrukturen i norske byer 

og tettsteder er bygd ned i en tiårs periode fra 1999 (Vista Analyse 2015). Det er knyttet stor 

usikkerhet til hvordan folketallet i Norge vil utvikle seg fremover, men ifølge Statistisk 

Sentralbyrå vil veksten være større enn tidligere og veksten vil først og fremst komme i sentrale 

strøk, og spesielt i de store byene (Leknes 2016). Med økte vannmengder som renner av på 
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overflaten, øker også behovet for å håndtere vannet for å unngå at det akkumuleres på ugunstige 

steder og på den måten medfører problemer. 

2.2.1 Konvensjonell overvannsdisponering 

Dagens ledningsnett for håndtering av avløps- og overvann består av et nett av rørledninger 

der vannet ledes til resipient ved bruk av selvfall eller pumping. Avløpsvannet ledes fra 

bebyggelsen via et renseanlegg før det føres ut i en resipient. Alle komponentene i systemet 

må oppfylle visse funksjonelle krav, men generelt sett er det gjerne selve ledningsnettet som er 

den begrensende faktoren for systemets totale kapasitet. Avløpssystem kan enten håndtere 

spillvann og overvann samlet i et fellessystem, eller atskilt i separatsystem. Tradisjonelt har de 

fleste avløpssystem i Norge vært fellessystem men stadig flere erstattes av separatsystem.  

Fellessystem gir tidvis stor belastning på ledningsnett og renseanlegg. Ved store 

nedbørepisoder overskrides kapasiteten når avrenningen tilfører mer vann til ledningsnettet enn 

det kan bortlede. En får da oppstuing, flom og blokkeringer i systemet. For å avlaste systemet 

settes det ofte inn overløp på strategiske punkter som trer i kraft når vannføringen overskrider 

ledningens maksimale kapasitetsnivå. Dette fører til at store mengder urenset avløpsvann 

renner ut i naturen. Det urensede vannet kan også strømme opp fra kummer når trykket blir for 

stort, og renne av sammen med regnvannet på overflatene. Separatsystem er derfor å foretrekke 

da overvannsystemet leder regnvannet direkte til resipient slik at belastningen på renseanlegget 

er mer stabil og spillvannet blir renset tilstrekkelig. Ledningene er dimensjonert ut fra kunnskap 

om nedbørforhold og befolkningsvekst på etableringstidspunktet og tar er derfor ikke høyde 

for økte vannmengder som følge av klimaendringer og fortettinger (NOU 2015:16). En 

oppdimensjonering av de konvensjonelle avløpssystemene vil alene være lite hensiktsmessig 

og er et altfor kostbart alternativ for å møte de fremtidige problemene med pluviale flommer i 

urbane områder. For å møte de nåværende og kommende utfordringene, har det de senere årene 

vært et økt fokus på at overvannet bør følge det naturlige avrenningssystemet framfor å bli 

transportert i ledninger. Dette kalles lokal overvannsdisponering (LOD). 
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Figur 2-3: Konvensjonell og lokal overvannsdisponering. Tilpasset fra NOU 2015:16. 

2.2.2 Lokal overvannsdisponering 

Lokal overvannsdisponering (LOD) innebærer at man utnytter lokalt naturgrunnlag i størst 

mulig grad som et alternativ til sentral oppsamling i avløpsnett. Overvannet infiltreres i 

grunnen, holdes tilbake i en fordrøyningsløsning eller en kombinasjon av disse. Ved infiltrasjon 

trenger vannet ned i underliggende grunn og infiltrasjonskapasiteten er avhengig av 

markoverflatens gjennomtrengelighet. Fordrøyning innebærer at vannet bremses på vei til 

utslipps- eller påslippspunkt. Dette kan gjøres ved at vannet mellomlagres før det infiltreres i 

bakken eller tilføres resipient eller avløpsnett. Når de store vannmengdene forsinkes vil det 

eksisterende avløpsnettet avlastes slik at flomtoppen forsinkes og reduseres. LOD bidrar også 

til at den naturlige vannbalansen i området opprettholdes, selvrensingsevnen utnyttes, samtidig 

som tiltakene tilfører kvaliteter til omgivelsene i form av økt trivsel i byrommet. Håndteringen 

av overvannet må tilpasses lokale forhold og behov, og må dimensjoneres til å fungere både 

ved flom og tørrværsavrenning (Lindholm 2014a). 

Hovedmålene som legges til grunn for overvannshåndtering innebærer skadeforebygging, 

utnyttelse av vannet som en ressurs og å styrke det biologiske mangfoldet (Lindholm et al. 

2008). For å oppnå dette anbefales det å følge en «treleddsstrategi» som gir veiledning i 

hvordan nedbørmengder av ulik størrelse skal håndteres. I det første leddet er nedbørmengdene 

så små at vannet kan fanges opp og infiltreres. Dette kan være ved hjelp av grønne tak, regnbed, 

porøse veidekker og andre tiltak lokalt. Ved større regnvolum vil det overskytende overvannet 

renne videre til åpne eller lukkede fordrøyningsanlegg der avrenningen forsinkes. Ved 

ekstremnedbør er nedbørmengdene så store at de normale systemene ikke kan håndtere 

avrenningen alene. I slike tilfeller anlegges sikre og trygge flomveier slik at vannet kan ledes 

kontrollert ut av området. Strategien er illustrert i Figur 2-4. For å minimere den hydrauliske 
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belastningen på overvannssystemet må det settes inn tiltak i alle de tre leddene. I øvre deler av 

systemet bør infiltrasjons- og fordrøyningstiltak kombineres, mens det kan være behov for 

fordrøyningsanlegg lenger ned i systemet. Istedenfor å vurdere tiltakene separat må hele 

avrenningssystemet vurderes samlet (Lindholm et al. 2008). 

 

Figur 2-4: Treleddsstrategi for håndtering av nedbør. Nedbørmengder må tilpasses lokalt. Tilpasset fra Lindholm et al. 

(2008). 

2.3 Nedbør  

Årlig faller det i gjennomsnitt 1450 millimeter nedbør i Norge. Variasjonene innad i landet er 

store, fra over 4000 millimeter i kystnære strøk på Vestlandet til under 400 millimeter i indre 

strøk på Østlandet (Thorolfsson 2014). Den mest intensive nedbøren med varighet på under tre 

timer, forekommer typisk i juli og august på Østlandet (DSB 2016).  

De skilles hovedsakelig mellom tre ulike nedbørtyper; konvektiv, orografisk og stratiform 

frontnedbør. De tre ulike typene gir opphav til ulik intensitet, varighet og romlig fordeling, og 

hvilken type nedbør som oppstår i et område har stor betydning for avrenningen. 

2.3.1 Nedbørtyper  

Orografisk nedbør er typisk for kystnære strøk med fjellformasjoner, og kjennetegnes ved lang 

varighet og lav intensitet over et stort areal. Orografisk nedbør oppstår når luftmasser tvinges 

oppover grunnet endringer i terrenget. Dersom løftehøyden av luftmassene er stor nok, vil lufta 

oppnå metning. Ved videre heving og avkjøling dannes skyer og en vil få nedbør. Stratiform 

nedbør, også kjent som storskala nedbør og frontnedbør, skyldes kollisjon mellom varm og 

kald luft. Nedbørtypen dannes i en varm- eller kaldfront, eller ved okklusjon. I en frontsone vil 

den varme luften presses over den kalde, og luften avkjøles. Ved tilstrekkelig avkjøling vil 

luften oppnå metning, og videre dannes det vanndråper eller iskrystaller som kan vokse til 

nedbør.  En varmfront oppstår når varm luft fortrenger kald luft, og en kaldfront oppstår når 
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kald luft fortrenger varm luft. Ved okklusjon tar en kaldfront igjen en varmfront og skyver 

varmluft opp i høyere luftlag. Stratiform nedbør kjennetegnes, i likhet med orografisk nedbør, 

ved lang varighet og lav intensitet over et stort areal. Stratiform og orografisk nedbør opptrer 

ofte samtidig. Konvektiv nedbør, også kjent som bygenedbør, betegnes som intens nedbør med 

kort varighet over et lite areal. Nedbøren er et resultat av oppvarming av luften nær bakken. 

Ved oppvarming vil luften stige opp, og videre avkjøles. Dersom luften inneholder tilstrekkelig 

mengder vanndamp og temperaturfallet er stort nok, vil en få sky- og dråpedannelse. Konvektiv 

nedbør er et typisk sommerfenomen, og det er området rundt Oslofjorden, samt deler av 

Sørlandskysten som har den mest intense bygenedbøren i Norge (Hanssen-Bauer et al. 2015). 

Nedbør kan måles som punktmålinger på bakkenivå eller som volumsegmenter fra værradar 

eller satellitt. 

 

Figur 2-5: Konvektiv, orografisk, og stratiform nedbør. Figuren viser hvordan de tre hovedtypene av nedbør oppstår. Tilpasset 

fra Nirman (2014 ). 

2.3.2 Nedbørdata fra bakkemålinger 

Nedbør kan måles i punkter på bakkenivå fra manuelle eller automatiske målestasjoner. 

Korttidsnedbør med varighet under 24 timer registreres på automatiske målestasjoner ved bruk 

av nedbørmålere kalt pluviometer. Det skilles mellom vippepluviometer og vektpluviometer.  

Vippepluviometer er basert på fylling av små vippeskåler der tidspunktet for hvert vipp 

registreres. Vippeskålene rommer 0,2 eller 0,1 millimeter og intensiteten på nedbøren kan 

beregnes ned til ett minutt. Vektpluviometer består av en bøtte hvor akkumulert nedbør veies 

fortløpende, med 10 minutters målinger (Førland et al. 2015). Målerne plasseres vanligvis i en 

høyde på to meter over bakken og plasseringen kan ha mye å si for måleusikkerheten, avhengig 

av bygninger og vekster i området rundt måleren. Måleusikkerheten til vippepluviometer er 

generelt lav, særlig ved høye nedbørintensiteter, og usikkerheten kan hovedsakelig knyttes til 

oppfangingssvikt på grunn av turbulens rundt måleren. I tillegg vil det være en viss usikkerhet 

knyttet til selve tidsangivelsen på dataene (Abdella & Engeland 2013). 
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For å få et inntrykk av den romlige fordelingen av nedbøren med utgangspunkt i punktmålinger 

er det utviklet ulike interpoleringsmetoder som Thiessenpolygon, invers avstandsvekting, 

kriging (Dingman 2002) og optimal interpolering (Lussana et al. 2016). En studerer da 

frekvensen av samtidig høy nedbørintensitet på nabostasjoner og tilegner områdene mellom en 

verdi. For at interpoleringen skal gi et representativt bilde av den romlige fordelingen kreves 

et tett nettverk av nedbørmålere. Ekstreme nedbørhendelser av konvektiv karakter oppstår ofte 

svært lokalt, og sannsynligheten for at nettverket av punktmålinger ikke fanger opp den mest 

intense nedbøren er stor. Interpolering vil dermed ikke gi et representativt bilde av en 

nedbørhendelse. Både punktmålinger fra nedbørstasjoner og verdier fra interpolerte 

punktmålinger benyttes til å lage konstruerte nedbørhendelser.  

2.3.3 Konstruert nedbør 

En konstruert nedbørhendelse har som formål å etterligne en reel nedbørhendelse, og benyttes 

som inngangsdata i avrenningsberegninger- og modeller. Ved konstruksjon av slike hendelser 

benyttes nedbørstatistikk som er representativ for området. Ofte tar en utgangspunkt i en 

intensitets-, varighets-, og frekvenskurve (IVF-kurve) fra nærmeste nedbørstasjon. Verdiene i 

en IVF-kurve er nedbørverdier som er utviklet for å kunne si noe om intensiteten, varigheten 

og frekvensen på nedbøren. Intensiteten er et mål på nedbørmengden som har falt per tidsenhet, 

varigheten definerer hvor lenge det faller nedbør med en bestemt intensitet, og frekvensen 

definerer hvor ofte nedbørhendelser ved en gitt intensitet og varighet forekommer. Frekvensen 

for en IVF-verdi kalles også returperioden eller gjentaksintervallet for hendelsen. En hendelse 

med gjentaksintervall på 100 år, også kalt 100-årsregn, kan ventes å opptre én gang hvert 100. 

år. Figur 2-6 viser IVF-kurven for Blindern nedbørstasjon i Oslo, basert på perioden 1968 – 

2015 for opptil 60 minutters varighet. For å opprette en IVF-kurve kreves det at nedbørstasjon 

har minst ti år med kvalitetskontrollerte data. IVF-verdier beregnes for nedbør med varighet 

ned til ett minutt (Norsk Klimaservicesenter 2017a).   

Den enkleste metoden å konstruere en nedbørhendelse er ved bruk av et kasseregn. Et 

kasseregn har konstant intensitet som bestemmes fra en gitt varighet på IVF-kurven. Ved bruk 

av kasseregnet mister en for- og etterregnet, og metoden fører til en undervurdering av det 

totale nedbørvolumet. For å ta hensyn til at en nedbørhendelse har varierende intensitet, og for 

å inkludere for- og etterregnet benyttes et regnhyetogram. Det antas at hyetogrammet er 

symmetrisk om sin midtakse og en tar utgangspunkt i at de mest intensive minuttene i 

hyetogrammet skal tilsvare regnvolumet i et kasseregn av samme varighet (Bøyum et al. 1997).  



13 

 

 

 

Figur 2-6: IVF-kurve for Blindern nedbørstasjon basert på perioden 1968-2015. Hentet fra eklima.no/Meteorologisk institutt. 

Regnintensiteten i tidsintervallet 𝐼𝑥 − 𝐼𝑦 er gitt som 

 

𝐼𝑥 − 𝐼𝑦 =  
𝐼𝑥𝑥 − 𝐼𝑦𝑦

𝑡𝑠
 

 

(2) 

der 𝐼𝑥 og 𝐼𝑦 er intensiteten for varighet 𝑥 og 𝑦 og 𝑡𝑠 er valgt beregningssteg i hyetogrammet. 

Generelt er 𝑥 større enn 𝑦 og differansen mellom disse er det dobbelte av 𝑡𝑠. De resulterende 

tidsintervallene speiles om aksen på hyetogrammet som vist i Figur 2-7. 

 

Figur 2-7: Symmetrisk regnhyetogram for 100-års gjentaksintervall. Regnhyetogrammet er laget med utgangspunkt i IVF-

kurven presentert i Figur 2-6. 
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Regnhyetogrammet tar hensyn til variasjonen i intensitet over tid, men tar ikke høyde for 

variasjonene i rommet. Siden IVF-kurven strengt tatt bare gjelder for arealet til pluviometerets 

oppsamlingsskål, vil bruken av konstruerte regn medføre en større eller mindre feil ved bruk 

over større områder (Lindholm 1983). Dette er likevel den mest brukte metoden for nedbørdata 

ved beregning av overvannsmengder.  

2.3.4 Nedbørdata fra værradar 

En værradar er et måleinstrument som bruker radiobølger til å måle avstand og retning til 

nedbør. Ved at værradaren skanner omliggende atmosfære måles radarreflektivitet, som videre 

konverters til nedbørintensitet. Radarreflektiviteten måles som et volumsegment, og er målt i 

en høyde som avhenger av avstanden fra radar til målt volum, radarens høyde over havnivå og 

radarens elevasjonsvinkel. Høyden på målt volumsegment er gitt ved 

𝐻 =  √𝑟2 + 𝑅𝐸
2 + 2sin (𝑡ℎ𝑅𝐸𝑟) −  𝑅𝐸 + ℎ0 

 

 

 

(3) 

der 𝑟 er avstanden fra radar til målt segment, 𝑅𝐸 er jordradiusen, 𝑡ℎ er strålingsvinkelen, og ℎ0 

er høyden på radarens plassering over havnivå (Rinehart 1997). Høyden på målt volumsegment 

kan ha stor betydning, da reflektiviteten varierer og er ikke-uniform i det vertikale sjiktet. 

Reflektiviteten avhenger av nedbørens fase som kan være hagl, snø, sludd eller regn. Ved 

ekstrapolering av reflektiviteten til bakkenivå benyttes VPR-korrigering. VPR står for «vertikal 

profile of reflectivity», og definerer reflektivitetens profil fra målt høyde til bakkenivå. 

Varierende reflektivitet i det vertikale sjiktet gjelder spesielt for stratiforme systemer når 

avstanden fra radaren er stor. Dette fører til usikkerhet i estimert radarreflektivitet på 

bakkenivå. For konvektive byger er feilen mindre, da nedbørskyene forplanter seg høyt 

oppover i atmosfæren, og variasjonene i reflektivitet er lavere (Abdella & Engeland 2013). Ved 

stor avstand fra radar til nedbørsystem av interesse vil en også ha demping som en 

usikkerhetsfaktor. Signalene fra radaren dempes av nedbør som ligger mellom radaren og 

nedbørsystemet. Dette fører til en underestimering av radarreflektiviteten. Fugler, insekter og 

andre bevegelige objekter representerer støy og kan gi mindre feil i den reflekterte radarstrålen.  

I tillegg kan nærliggende objekter som vegetasjon, bygninger og terreng blokkere radarstrålen 

og gi systematiske feil. Feilkildene som påvirker kvaliteten på værradarobservasjoner er 

illustrert i Figur 2-8. 
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Figur 2-8: Skjematisk oversikt over feilkilder som påvirker værradarobservasjonenes kvalitet. Tilpasset fra Holleman (2006). 

Akkumulert nedbør kan estimeres ved bruk av Marshall-Palmer relasjonen (Marshall & Palmer 

1948), gitt ved 

 

𝑍 = 𝑎𝑅𝑏 

 

 

(4) 

der 𝑍 er radarreflektiviteten, 𝑅 er nedbørintensiteten, og 𝑎 og 𝑏 er variabler som avhenger av 

nedbørtype (Rinehart 1997). Verdier for 𝑎 og 𝑏 publisert med Z-R relasjonen i Marshall og 

Palmer (1948) var 𝑎 = 220 og 𝑏 = 1,6. Det finnes nå en rekke ulike verdier for parameterne. 

Battan (1973) listet opp over 60 ulike verdier, og det er i senere tid publisert lagt flere. Verdiene 

treffer godt i snitt, men blir mer usikre for høye nedbørintensiteter. Det er dermed knyttet stor 

usikkerhet til konverteringen av radarreflektivitet til nedbørintensitet i ekstreme 

nedbørhendelser. For radarnettverket i Norge brukes 𝑎 = 200 og 𝑏 = 1.6 for konvektive 

sommerbyger (Ødemark et al. 2012). 

For værvarsling i Norge er det bygd ut ett nettverk av elleve c-båndradarer. En c-båndradar har 

en rekkevidde på 240 km og mottar signal hvert 7,5 minutt i en oppløsning på 1x1 kilometer. I 

tillegg til de elleve c-båndradarene, har også meteorologisk institutt en mobil x-båndradar. En 

x-båndradar har en rekkevidde på 50 km og mottar signal hvert minutt, i en oppløsning på 

250x250 meter. Ved sammenligning av de to radarene har x-båndradaren 16 ganger så høy 

oppløsning på rutenettet og 7,5 ganger så høy oppløsning i tid sammenlignet med c-

båndradarene. En x-båndradar egner seg dermed bedre til å måle ekstreme nedbørhendelser, da 

de lokale forskjellene er store og nedbøren endrer seg mye over kort tid. Figur 2-9 viser bilde 

av den mobile x-båndradaren på taket av Helsfyr Panorama sommeren 2015, samt en 
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illustrasjon av sanntidsdata den 8. februar 2017 fra c-båndradarene på Hurum i Buskerud og 

Lista i Vestfold (Meteorologisk institutt 2017b).  

 

Figur 2-9: X-båndradaren på Helsfyr og sanntidsdata over Sørøst-Norge. Figuren til venstre viser bilde av x-båndradaren 

plassert på taket til Helsfyr Panorama. Figuren til høyre viser radarbilder fra c-båndradarene plassert på Hurum i Buskerud 

og Lista i Vestfold. Figurene er hentet fra Lauvås et al. (2016) og Meteorologisk institutt (2017b). 

2.3.5 Bakkekorrigering av værradardata 

Parameterne 𝑎 og 𝑏 i Z-R-relasjonen beskrevet i ligning 4 er som nevnt avhengig av 

nedbørtype, og baserer seg på empiriske målinger med lange tidsserier. Relasjonen treffer godt 

i snitt, men verdiene for 𝑎 og 𝑏 er usikre for større nedbørhendelser av konvektiv karakter. 

Dette kan føre til at værradaren underestimerer nedbøren og verdiene kan avvike mye fra 

observerte verdier på nedbørstasjoner. Det finnes flere måter å forbedre nøyaktigheten til 

radardataene. Bakkekorrigering fremstår i litteraturen som den mest brukte metoden (Germann 

et al. 2009; Gjertsen et al. 2004; Lepioufle 2015; Smith & Krajewski 1991; Steiner et al. 1999). 

Ved å korrigere radardata mot bakkemålinger kombinerer en de individuelle styrkene ved de 

to målemetodene. Radardata inneholder informasjon om den romlige fordelingen av nedbøren 

mens nedbørstasjonene gir punktmålinger med relativ stor kvantitativ nøyaktighet. Ved å anta 

at bakkemålinger er den sanne verdi, kan sammenhengen mellom nedbør fra 

nedbørstasjonen 𝑅𝑇𝑅𝑈𝐸 og nedbør fra værradaren 𝑅 skrives som  

 

𝑅𝑇𝑅𝑈𝐸 =  𝑅 +  𝜀 
 

 

(5) 

der 𝜀 er feilen til nedbørdata i radaren. I følge Germann et. al (2009) er feilen hovedsakelig 

multiplikativ, slik at ligning 5 kan uttrykkes logaritmisk 

 

𝜀𝑑𝐵 =  10log (
𝑅𝑇𝑅𝑈𝐸

𝑅
) 

 

 

 

(6) 
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𝜀𝑑𝐵 kan antas å være normalfordelt når den er uttrykt i desibel (dB) og korrelerer i tid og rom 

(Germann et al. 2009). Dette kan uttrykkes som 

 

𝜀𝑑𝐵 =  𝑁(𝜇, 𝜎, 𝐿, 𝑇) 
 

 

(7) 

der N beskriver Gaussfeltet representert av gjennomsnittet 𝜇, standardavviket 𝜎, romlig 

oppløsning 𝐿 og tidsoppløsningen 𝑇. Antagelsen om at bakkemålingene tilsvarer den faktiske 

nedbøren i punktet krever at målingene fra nedbørstasjonene er kvalitetkontrollerte og målt 

med en høy grad av nøyaktighet. Videre må en anta at nedbørdata fra nedbørstasjonene og 

værradaren er gyldig for de samme stedene i tid og rom. Antakelsen er grov da værradaren 

måler volumsegmenter høyt over jordens overflate i motsetning til nedbørstasjonene som måler 

nedbøren på bakkenivå. Usikkerheten er lavere når avstanden mellom nedbørstasjonene og 

værradaren er liten, og høyere for større avstander. En forutsetter også at forholdet mellom 

nedbørstasjonene og værradaren er gjeldende også for andre punkter i rom og/eller tid 

(Koistinen & Puhakka 1981). Ved å anta at feilen i radardataene ikke varierer i rommet, kan 

en løsning av ligning 7 være midlere feil (MF) gitt som 

𝑀𝐹 =  
∑ 𝐺𝑖

∑ 𝑅𝑖
 

 

 

 

(8) 

der 𝐺𝑖 og 𝑅𝑖 er akkumulert nedbør fra henholdsvis nedbørmåler og radarobservasjoner for 

nedbørmåler 𝑖 i et gitt tidsintervall. Tidsintervallet bør velges slik at tilfeldige feil ikke får for 

stor betydning samtidig som det bør ta høyde for de store endringene i nedbøren som oppstår 

over kort tid. MF-korrigering gir den samme korreksjonsfaktoren over hele området og 

beholder den romlige nedbørdistribusjonen slik den måles av radaren (Abdella & Engeland 

2013; Gjertsen et al. 2004; Smith & Krajewski 1991; Steiner et al. 1999). Det er også utviklet 

ulike metoder som tar høyde for korreksjonsfaktorens variasjon over feltet. I litteraturen brukes 

interpoleringsmetoder som kriging (Haberlandt 2007; Krajewski 1987; Sinclair & Pegram 

2005), invers avstandsvekting (Haberlandt 2007) og optimal interpolering (Lussana et al. 2016; 

Mahfouf et al. 2007) for å bedre den romlige oppløsningen til sluttproduktet.  

Ved å la korreksjonsfaktoren variere i rommet kan en få bedre prediksjoner på korrigerte 

værradardata. Samtidig er metoden mindre robust og det kreves et stort antall målepunkter for 

å kunne si noe om den romlige korrelasjonen til korreksjonsfaktorene. 
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2.4 Avrenningsberegning og modellering 

For beregning av overvann benyttes både manuelle metoder og mer avanserte databaserte 

modeller. Den mest anvendte manuelle metoden for å beregne avrenning fra et nedbørfelt er 

den rasjonelle formelen, gitt ved 

𝑄 = 𝜙𝐼𝐴 
 

(9) 

der  𝜙 er avrenningskoeffisienten, 𝐼 er nedbørintensitet per arealenhet og 𝐴 er nedbørfeltets 

areal. Avrenningskoeffisienten 𝜙 representerer forholdet mellom avrenningen og nedbøren i et 

område. Koeffisienten avhenger av overflatens permeabilitet, ruhet og fallforhold, samt 

nedbørens intensitet og varighet. Nedbørintensiteten ved en gitt varighet hentes fra en IVF-

kurve. Den rasjonelle formelen er begrenset til en konstant regnintensitet (kasseregn), samt en 

konstant gjennomsnittlig avrenningskoeffisient for hele området. Dette gir gode 

overslagsverdier, men er en sterk forenkling av virkeligheten. For beregning av 

overvannsmengder fra flere delfelt benyttes summasjonskurvemetoden. Metoden tar hensyn til 

forsinkelsene som finner sted fra hvert delfelt samt delfeltenes innvirkning på den samlede 

avrenningen. De manuelle metodene er begrenset til bruk på nedbørfelt opptil 50 hektar 

(Lindholm 2014a). For overvannsberegninger i større og mer komplekse områder benyttes 

databasert matematisk modellering.   

En matematisk modell er en matematisk formulering av fysiske prosesser. Ideen med en 

matematisk modell er å la likninger uttrykke fysiske hendelser i den virkelige verden. Slike 

modeller beregner, analyserer, simulerer og predikerer hendelsesforløp mange ganger raskere 

enn ved bruk av manuelle metoder og er derfor effektive verktøy i planlegging, prosjektering, 

dimensjonering og drift av overvannssystemer. Varsler og prognoser basert på slike modeller 

vil alltid ha en iboende usikkerhet, og er i beste fall en tilnærming av virkeligheten. Både 

diskretisering og observerte inngangsdata gir opphav til usikkerhet i modellen. I tillegg kan 

innhenting av data og brukerens forståelse av de fysiske prosessene være en kilde til usikkerhet. 

Usikkerheten gjøres mindre ved verifisering, kalibrering og validering. Ved modellverifisering 

kontrolleres det at modellen løser de matematiske ligningene riktig, ved kalibrering 

kontrolleres modellens følsomhet ved endring i inngangsparametere og ved validering 

etterprøves modellens resultat mot observerte målinger (Adam 2003). 

For modellering av overvannsavrenning benyttes enten enkle GIS-analyser eller 

todimensjonale hydrauliske modeller. En GIS-analyse identifiserer lavbrekk i terrenget og kan 

samtidig beregne lavbrekkenes tilsigsområde og flomveier. Nedbøren som faller i en rute vil 
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alltid strømme til den av de åtte omliggende rutene som har lavest verdi. Analysen gjør ingen 

hydrauliske beregninger og innehar derfor ingen informasjon om mengde nedbør som skal til 

for å fylle forsenkningene (Mårtensson & Gustafsson 2014).  

Todimensjonale modeller gjør hydrauliske beregninger i hver rute og gir dermed mer nøyaktige 

modeller. De kan i tillegg gi informasjon om oversvømmelsens tidsforløp, hastighet og 

volumstrøm. Nedbøren som faller i en rute har fire potensielle veier videre, avhengig av 

helningen på terreng og vannivået i de omkringliggende rutene. Vannet kan i tillegg lagres i 

den gjeldende ruten som illustrert i Figur 2-10 (Engineers Australia 2012). Det finnes også 

hydrauliske endimensjonale modeller som beregner vannets oppstuvning i ledningsnettet. Ved 

å kombinere en todimensjonal avrenningsmodell med en ledningsnettsmodell får man en 

modell som beskriver dynamikken mellom avløpssystemet og overflateavrenningen ved en 

nedbørepisode. 

 

Figur 2-10: Potensielle strømningsretninger for nedbør som faller på en rute eller et mesh i todimensjonale hydrauliske 

modeller. Tilpasset fra Engineers Australia (2012). 

2.5 MIKE 21 Flow Model FM 

MIKE 21 Flow Model er en programvare utviklet av det Danske Hydrauliske Institutt (DHI). 

Programvaren er et hydraulisk modelleringssystem for todimensjonal strømning med fritt 

vannspeil og brukes hovedsakelig til kyst- og havmodellering. Programvaren kan benyttes i 

alle vannmiljøer der lagdeling kan neglisjeres og er derfor anvendelig til modellering av pluvial 

flom (DHI 2016b). 

Modellen finnes i to versjoner som presenterer den topografiske informasjonen ulikt, raster og 

flexible mesh (FM). Et raster er en terrengmodell som består av et rutenett av rektangler med 
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en gitt størrelse og et FM er bygd opp av små ikke-ortogonale trekanter av ulike størrelse. 

Videre beskrivelse av MIKE 21 Flow Model er basert på FM.  

MIKE 21 Flow Model FM består av en hydrodynamisk modul som simulerer variasjoner i 

vannstand og strømninger. Modulen tar utgangspunkt i Navier-Stokesligningene som beskriver 

strømningen til et fluid i tre dimensjoner under påvirkning av gravitasjon og uttrykkes ved 

bevaring av masse og bevegelsesmengde. Integrasjon av massebevaring- og bevegelses-

mengdeligningene over vanndybden gir opphav til gruntvannsligningene som den 

hydrodynamiske modulen baseres på. Massebevaring integrert over vanndybden er gitt som 

𝜕ℎ

𝜕𝑡
+

𝜕ℎ𝑢̅

𝜕𝑥
+

𝜕ℎ𝑣̅

𝜕𝑦
= ℎ𝑆  

 

(10) 

der ℎ er total vanndybde, 𝑢̅ og 𝑣̅ er hastighetskomponenter i x- og y- retning, 𝑡 er tid og 𝑆 er 

utslipp fra punktkilder (DHI 2016a). Bevegelsesmengde integrert over vanndybden i x- og y-

retning er gitt i henholdsvis ligning 11 og 12 
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(11) 
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(12) 

der ℎ er total vanndybde, 𝑢̅ og 𝑣̅ er hastighetskomponenter i x- og y- retning, 𝑡 er tid, 𝑓 er 

coriolisparameter, 𝑔 er tyngdens akselerasjon, 𝜂 er overflatehøyde, 𝜌 er vannets tetthet, 𝑝𝑎 er 

atmosfærisk trykk, 𝜏𝑠 og 𝜏𝑏 er skjærspenning for henholdsvis vind og overflate, 𝑠 er 

strålingskomponent og 𝑆 er utslipp fra punktkilder. 𝑇 representerer vertikal belastning i form 

av friksjon og adveksjon estimert ved bruk av eddy-viskositet (DHI 2016a). 

Integreringen begrenses til situasjoner der hastighetsendringen som funksjon av vanndybden 

er så liten i forhold til endringene i horisontal retning at den kan neglisjeres. Ligning 10, 11 og 

12 er derfor begrenset til tilfeller der vannet har relativt lav dybde. Dette inkluderer blant annet 

tidevannshydraulikk, vind- og bølgestrømmer, stormflo og strømning i elver. Siden vann som 
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renner av på overflaten ved nedbørepisoder ofte har en relativt lav høyde, kan modeller basert 

på gruntvannsligningene også brukes til overvannsformål.  

Den romlige diskretiseringen av ligningene løses sammen med initial- og grensebetingelser 

ved bruk av en cellesentrert endelig volum metode (FVM). En approksimativ Riemannløser 

benyttes for å beregne de konvektive fluksene mellom cellene slik at diskontinuerlige løsninger 

kan håndteres. Vanndybden og hastighetskomponentene evalueres i midten av cellene mens 

fluksen beregnes vinkelrett på de tre celleveggene (DHI 2016a). For tidsintegrasjonen benyttes 

den eksplisitte differensialmetoden «upwind» som begrenser tidssteget i simuleringen til å 

tilfredsstille et spesifikt Courant-Friedrich-Lewy (CFL) tall mindre enn 1 for å unngå ustabile 

og unøyaktige resultater (Engineers Australia 2012). For gruntvannsligningene er CFL-tallet 

definert som 

𝐶𝐹𝐿 = (√𝑔ℎ +  |𝑢|)
∆𝑡

∆𝑥
+ (√𝑔ℎ + |𝑣|)

∆𝑡

∆𝑦
 

 

(13) 

der ℎ er total vanndybde, 𝑢 og 𝑣 er hastighetskomponenter i x- og y- retning, ∆𝑡 er 

tidsstegsintervall og 𝑔 er tyngdens akselerasjon (DHI 2016b). Lengdeskalaene ∆𝑥 og ∆𝑦 

tilnærmes av den minste lengden på hver celle. Cellestørrelsen og vinkelen mellom 

cellekantene har dermed innvirkning på CFL-tallet som igjen påvirker beregningstiden. For å 

holde simuleringstiden nede bør derfor tidsstegsintervall og celler velges slik at CFL-tallet blir 

så lavt som mulig. 

2.5.1 Modellparametere 

MIKE 21 Flow Model FM simulerer de hydrodynamiske forholdene med hensyn til ulike ytre 

tvingende parametere og grensebetingelser (DHI 2016b). Formålet med analysen bestemmer 

hvilke parametere som inngår i modellen og hvilke som kan neglisjeres. Parametere med 

viktighet for simulering av overflateavrenning er presentert i det følgende.  

Terrengmodell og grensebetingelser 

Terrengmodellen gir en beskrivelse av et områdes topografi og har følgelig stor innvirkning 

for hvordan flommer utvikler seg. Den topografiske informasjonen er lagret i små fleksible 

trekanter i et flexible mesh (FM). De ustrukturerte trekantene gjør det mulig å tilegne områder 

av spesiell interesse større oppløsning og dermed en mer nøyaktig terrengbeskrivelse. Dette 

kan være områder med høy urban faktor eller områder med komplekse høydeforhold. Områder 

som anses som mindre viktige for flomforløpet kan på samme måte ha redusert oppløsning. 

Den ustrukturerte oppløsningen gjør det også mulig å kombinere forskjellige lag med ulik 
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oppløsning til bruk i modeller, i motsetning til rasterlag som krever at lagene har ruter med 

samme størrelse.  FM-modellenes kompleksitet gjør at simuleringstiden er mellom fire og åtte 

ganger så lang som i raster-modellene (Engineers Australia 2012). For å håndtere de lange 

beregningstidene har DHI gjort det mulig for FM å benytte maskinakselererende grafikk slik 

at bruk av maskiner med bra grafikkprosessor (GPU) vil gi en stor økning i 

simuleringshastigheten (DHI 2016c).  

Terrengmodellen bygges opp i MIKE Zero verktøyet Mesh Generator og modellens 

utstrekning defineres av åpne og lukkede grenser. Langs de lukkede grensene er strømningen 

null for alle variabler mens de åpne grensene lar vannet strømme igjennom.  

Vannivået i trekantene vil stadig variere gjennom simuleringen. Nivået overvåkes og 

trekantene klassifiseres som tørre, delvis tørre og våte. Dette betraktes som bevegelige grenser 

og benevnes «Flood and dry». De bevegelige grensene gjør det mulig for beregningene å 

inkludere og ekskludere trekanter dynamisk under simulering. I trekantene som defineres som 

våte benyttes alle de tre gruntvannsligningene ved beregning. De delvis tørre trekantene 

beregnes kun ved bruk av massebevaringsligningene mens de tørre trekantene kobles helt ut av 

beregningene. Lave verdier gir større nøyaktighet, men kan også føre til ustabiliteter i 

modellen. Generelt gjelder 

ℎ𝑑𝑟𝑦 < ℎ𝑓𝑙𝑜𝑜𝑑 < ℎ𝑤𝑒𝑡 

 

(14) 

der ℎ representerer vannivået for henholdsvis tørre, delvis tørre og våte celler.  

Nedbør 

Nedbør er sammen med terrengmodellen den viktigste inngangsparameteren i en avrennings-

modell. Nedbør kan inkluderes i modellen som en konstant verdi i alle rutene, varierende i tid, 

eller varierende i tid og rom. Normalt brukes tidsvarierende historiske hendelser fra 

nedbørstasjoner eller konstruerte regnepisoder basert på IVF-kurver. Evaporasjon kan legges 

inn sammen med nedbøren som konstant, tidsvarierende eller varierende i tid og rom.  

Ruhet 

For å kunne gi en pålitelig beskrivelse av overflatestrømningen, må en ta hensyn til overflatens 

ruhet. Ruheten beskriver hvordan strømmende vann påvirkes av underlaget det strømmer på 

og avhenger av underlagets friksjon. Friksjonstap som følge av ruhet beskrives av Mannings 

formel 
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𝑣 = 𝑀𝑅
2
3𝐼

1
2 

 

(15) 

der 𝑣 er vannhastighet i tverrsnittet, 𝑀 er Mannings ruhetstall, 𝑅 er hydraulisk radius og 𝐼 er 

helningen på underlaget. Den hydrauliske radiusen defineres av forholdet mellom 

strømningsarealet og vætet perimeter. Den representerer et mål på den gjennomsnittlige 

avstanden fra vannet til bunnen der friksjonen oppstår. Jo lavere verdi, dess større innvirkning 

på ruheten. I modellen benyttes «bred kanal-tilnærming», det vil si at når bredden er mye større 

enn vanndybden settes den hydrauliske radiusen lik vanndybden. Ruhetstallet varierer med 

underlaget og er typisk høyest for harde og glatte underlag som asfalt og betong og lavere for 

vegetasjonsdekkede flater (Lindholm 2014b). I følge ligning 15 vil dermed asfalterte dekker gi 

høyest vannhastighet.  

I MIKE 21 Flow model kan ruhet legges inn med samme verdi for hele feltet eller med ulik 

verdi for hver celle. Overflateskjærspenningen beskrives i modellen med en kvadratisk 

friksjonslov  

𝜏𝑏̅

𝜌0
=

𝑔𝑢̅𝑏|𝑢̅𝑏|

(𝑀ℎ
1
6)2

 

 

(16) 

der 𝑢̅𝑏 er overflatehastigheten, ℎ er total vanndybde, 𝑀 er Mannings tall, 𝜌0 er vannets tetthet 

og 𝑔 er tyngdens akselerasjon (DHI 2016a). 

Infiltrasjon 

Effekten av infiltrasjon kan være stor ved overflateavrenning. Infiltrasjonsraten avhenger av 

avrenningsflaten og jordens fysiske egenskaper som kornstørrelse, porøsitet og 

fuktighetsinnhold. Videre har jorddybde og lagdeling innvirkning på hvor mye vann jorden kan 

lagre. Ved nedbørshendelser mettes jorden med vann slik at infiltrasjonen avtar med tiden.   

I MIKE 21 Flow Model kan man velge mellom å legge inn netto infiltrasjon, ingen infiltrasjon 

og konstant infiltrasjon med kapasitet (DHI 2016b). I den førstnevnte metoden kan 

infiltrasjonen være konstant eller variere i tid og/eller rom. Vanndybden i cellene beregnes for 

hvert tidssteg ved bruk av den endimensjonale vertikale kontinuitetsligningen 

𝐻(𝑗) = 𝐻(𝑗)𝑖 −
𝑉𝑖𝑛𝑓(𝑗)

𝐴(𝑗)
 

(17) 
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der 𝑉𝑖𝑛𝑓 er det infiltrerte volumet i elementet 𝑗 og 𝐴(𝑗) er arealet av elementet. Den umettede 

sonen er ikke definert og har derfor ingen kapasitetsbegrensninger. Infiltrasjon vil skje så lenge 

cellen er oversvømmet.   

Ved konstant infiltrasjon med kapasitet beskrives infiltrasjonen fra den frie overflaten til 

umettet sone, og ved perkolasjon videre fra umettet sone til mettet sone i en forenklet modell. 

Modellen krever i tillegg informasjon om porøsitet og dybde på infiltrasjonslaget, 

infiltrasjonsrate til mettet sone, og vanninnhold i infiltrasjonslaget (DHI 2016a). Ved store 

nedbørhendelser kan man anta at nedbørhendelsen er av en slik størrelse at infiltrasjonen kan 

neglisjeres.  

Eddy-viskositet 

MIKE 21 integrerer skjærspenning assosiert med turbulens ved parameteren eddy-viskositet 

som er integrert i ligningene for bevegelsesmengde, ligning 11 og 12. Eddy-viskositet kan 

innlemmes i modellen som en konstant verdi, eller beregnes dynamisk ved bruk av 

Smagorinskys formel. I tilfeller der rutestørrelsen i modellen er større enn vanndybden brukes 

konstant eller ingen eddy-viskositet. Når rutestørrelsen er mindre eller lik vanndybden bør 

Smagorinskys formel benyttes (Engineers Australia 2012). 

2.6 Tidligere arbeid 

Nedbørens romlige oppløsning og metoder for å fange opp denne ble studert allerede på 70- og 

80-tallet til vann- og avløpsformål. (Lindholm 1983; Niemczynowicz 1982). I studiene ble 

ulike interpoleringsmetoder benyttet for å ta høyde for nedbørens romlige variasjon. Værradar 

ble nevnt som et mulig verktøy for å fange opp nedbørens romlige oppløsning, men ble vurdert 

som for usikker med datidens teknologi. Radarteknologiutviklingen har siden vært stor og det 

foreligger mye forskning på værradardataenes kvalitet både i Norge (Abdella & Alfredsen 

2010; Gjertsen et al. 2004; Lepioufle 2015) og internasjonalt (Einfalt et al. 2005; Steiner et al. 

1999). Forskningen omhandler hovedsakelig ulike metoder for å korrigere radardataene mot 

de målte verdiene på bakkenivå samt ulike kombinasjoner av ZR-relasjonen for konvertering 

av radarreflektivitet til bakkenedbør.  

Værradardata benyttes daglig i Meteorologisk institutts værvarslingsmodeller og det foreligger 

noe forskning på bruk i hydrologiske modeller i vannkraftbransjen (Abdella et al. 2012). I 

Danmark er det sett på muligheten for å bruke data fra en x-båndradar i ledningsnettmodellen 

MIKE Urban (Pedersen et al. 2009). Konklusjonen fra dette studiet er at MIKE Urban henter 
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nedbørinformasjon fra radarruten nærmest delnedbørfeltenes senter, slik at bruk av værradar 

ikke tilfører modellen forbedret romlig oppløsning sammenlignet med bruk av konstruerte 

nedbørepisoder. For å utnytte værradarens romlige oppløsning må analyseområdet i 

ledningsnettmodellen deles inn i delnedbørfelt med samme oppløsning som radaren.  

Ved Norges miljø- og biovitenskapelige universitet er det tidligere skrevet fire oppgaver om 

utprøving av metodikk for avrenningsmodellering i Drammen kommune. Myrvoll (2015) og 

Murtnes (2015) tok for seg metodikk for produksjon av aktsomhetskart i ArcGIS, Johansen og 

Moldekleiv (2016) sammenlignet avrenning i ArcGIS med avrenning fra de hydrauliske 

avrenningsmodellene MIKE 21 og MIKE Flood, og Abry (2016) videreutviklet modellene med 

avansert inngangsdata for infiltrasjon og ruhet.  
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3 Metode  

3.1 Sammenligning av nedbørdata fra værradar og nedbørstasjoner 

3.1.1 Analyseområde  

Analyseområdet for det sammenlignende studiet av data fra værradar og nedbørstasjoner 

omfatter sentrumsområdene i Drammen kommune. Drammen ligger i et dalføre ved 

Drammenselvens utløp i fjorden og sentrumsområdet ligger om lag to meter over havet, med 

tett bebyggelse både langs elva og oppover åssidene på begge sider. Området er valgt på 

bakgrunn av det tette nettverket av nedbørstasjoner med vippepluviometre og dekningsgraden 

til x-båndradaren på Helsfyr. Drammen sentrum har flere ganger vært utsatt for ekstreme 

nedbørhendelser med påfølgende oversvømmelser de siste årene (Drammens Tidende 2007; 

2009; 2012; 2016), noe som gjør området aktuelt for studiet. 

3.1.2 Nedbørhendelse  

Nedbørhendelsen benyttet i studiet fant sted den 11. juli 2016 mellom klokken 12.30 og 15.40. 

Hendelsen er valgt etter en sammenligning av ekstreme nedbørhendelser som har truffet 

analyseområdet etter at x-båndradaren ble satt opp på Helsfyr sommeren 2015. 

Nedbørhendelsen har konvektiv karakter og bygeretning sydøst i retning Oslofjorden, som er 

typisk for denne type hendelser (Lindholm & Aune 1984). I forkant av hendelsen kom det en 

mindre nedbørhendelse, men denne er utelatt fra studiet da oppholdstiden mellom de to 

hendelsene var flere timer.  

Hendelsen 11. juli førte til oversvømmelser i Drammen sentrum. Både Bragernestunnelen på 

nordsiden av Drammenselven og Strømsåstunnelen på sørsiden ble stengt. Figur 3-1 og Figur 

3-2 viser utklipp og bilder fra Drammens Tidende etter hendelsen. 

 

Figur 3-1: Nyhetsoppslag i Drammens Tidende 13.juli 2016. 
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Figur 3-2: Oversvømmelser i Bragernestunnelen. Publisert i Drammens Tidende den 11. juli 2016.  Foto: Rune Folkedal og 

Borgvald Moen. 

3.1.3 Data fra nedbørstasjoner  

I Drammen sentrum er det syv nedbørstasjoner innenfor en radius på 4,5 kilometer som 

registrerte nedbørhendelsen den 11. juli 2016. Samtlige av disse er satt opp for å måle ekstreme 

nedbørhendelser og har vært i drift siden januar 2015. Stasjonene har nedbørmålere av typen 

Lambrecht vippepluviometer, har en oppløsning på 0,1 mm og måler akkumulert nedbør hvert 

minutt. Stasjonene eies av Drammen kommune og driftes av Rosim AS. 

 

Figur 3-3: Nedbørstasjoner i analyseområdet i Drammen. Bildet til venstre viser plasseringen av de syv nedbørstasjonene i 

Drammen sentrum (Kjølseth og Vatne). Bildet til høyre viser vippepluviometer av typen Lambrecht som står på de syv 

stasjonene. Fotograf: met.no.  

Nedbørseriene fra nedbørstasjonene er tilgjengelige på meteorologisk institutts klimadatabase, 

Eklima (Meteorologisk institutt 2017a). Det er i denne oppgaven hentet ut kvalitetskontrollerte 

nedbørserier fra hver av nedbørstasjonene på minuttoppløsning. 
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3.1.4 Data fra værradar  

I Meteorologisk institutts nettverk av værradarer er det to radarer som har dekningsgrad over 

analyseområdet og som målte hendelsen den 11. juli. Radaren på Hurum er en c-båndradar med 

en rekkevidde på 240 kilometer. C-båndradaren sveiper omliggende atmosfære hvert 7,5 minutt 

og måler i en ruteoppløsning på 1x1 kilometer. Avstanden fra Hurum til analyseområdet er om 

lag 23 kilometer. Radaren på Helsfyr er en x-båndradar med en rekkevidde på 50 kilometer. 

X-båndradaren sveiper omliggende atmosfære for hvert minutt og måler i en oppløsning på 

250x250 meter. Avstanden mellom Helsfyr og analyseområdet er om lag 38 kilometer.  

Avstanden, og dermed høyde for målt reflektivitet, argumenter for at radaren på Hurum kunne 

vært det beste alternativet. Samtidig fører den lave strålen til at hindringer som bygninger og 

andre objekter skaper mer støy i radarbildet, spesielt for de urbane områdene. Studert hendelse 

er av konvektiv karakter med svært hyppige endringer i tid og rom. X-bånd radaren har 16 

ganger større oppløsning i rom enn c-båndradaren, og 7,5 ganger så stor oppløsning i tid, noe 

som tilfører datasettet et langt større detaljnivå. Med bakgrunn i overnevnte argument ble det 

besluttet å benytte data fra radaren på Helsfyr.  

 

Figur 3-4: X-båndradarens dekningsområde på 50 kilometer. Værradaren på Helsfyr er illustrert i svart og nedbørstasjonene 

i Drammen i rødt. Illustrasjon laget av Kjølseth og Vatne. 

Figur 3-4 viser et oversiktskart med et utsnitt av Helsfyrradarens dekningsområde. Med en 

avstand på anslagsvis 38 kilometer mellom radaren og Drammen sentrum, og laveste 
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strålingsvinkel på 2 grader, gir likning 3 i kapittel 2.3.4 at radarreflektiviteten er målt i en høyde 

lik 1600 meter over analyseområdet.  

Figur 3-5 viser flytskjema for prosessen fra målt radarreflektivitet til nedbørintensitet som 

inngangsdata i en avrenningsmodell. Målt radarreflektivitet Z blir først justert for 

bakgrunnsstøy og demping. Videre er målt reflektivitet i 1600 meters høyde VPR-korrigert til 

reflektivitet på bakkenivå, og radarreflektiviteten er omgjort til nedbørintensitet R ved bruk av 

Marshall-Palmer relasjonen gitt i likning 4, kapittel 2.3.4. Benyttede verdier for 𝑎 og 𝑏 er 

henholdsvis 200 og 1,6. Datasettet er tilegnet koordinatsystem og projeksjon WGS1984 

UTM32.   

 

Figur 3-5: Flytskjema av prosessering av radardata. Flytskjemaet viser prosessen fra målt reflektivitet i et volumsegment, til 

akkumulert nedbør. Korrigering mot bakkemålinger er ikke gjort i datasettet fra meteorologisk institutt. Tilpasset fra Abdella 

(2016). 

Radardataene benyttet i denne oppgaven er levert og bearbeidet av Christoffer A. Elo ved 

Meteorologisk institutt, og er hentet ut fra Meteorologisk institutts database Thredds 

(Meteorologisk institutt 2017c). Dataene ble hentet ut på filformatet netCDF på 

minuttoppløsning, med varighet på et døgn. Dette tilsvarer 1400 tidssteg. Dataene er ikke 

korrigert mot bakkemålinger ved meteorologisk institutt slik det fremgår i flytskjema. Dette er 

utført etter mottatt datasett, før værradardataene er avendt i avrenningsmodellen.  

NetCDF er et filformat velegnet for etablering, lagring og deling av store matriseorienterte 

datasett som klimadata. Programvarer som behandler denne type filer er foreløpig begrenset 

og bearbeiding av slike datasett bør ideelt sett gjøres i objektorienterte programmeringsspråk 

som C++ og Python. I lys av oppgavens omfang ble det besluttet å teste ut ferdige programvarer 

med enkelt brukergrensesnitt for bearbeiding av radardataene. ArcMap ble testet ut som et 

alternativ, med ArcToolbox-verktøyet Make NetCDF Raster Layer (Multidimension). Dette 

viste seg å være mindre egnet og tungt å jobbe med. Siden det var ønskelig å få radardataene 

inn som inngangsdata for nedbør i en avrenningsmodell fra MIKE 21 var det hensiktsmessig å 

ha datasettet i et filformat anvendbart i MIKE programvare (dfs2). Ulike metoder og verktøy 

ble testet ut, men datasettet ble enten fratatt tidsvariabelen eller det geografiske 
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koordinatsystemet. Det ble omsider tilpasset et verktøy til vårt bruk av DHI Singapore, 

NetCDF/Grib2 To DFS Format Conversion. Verktøyet er ikke utviklet for radardata direkte, 

men var anvendbart med noe etterarbeid med koordinatsystem og enhetsskalering. NetCDF- 

filen fra meteorologisk institutt har nedbørrate med enhet mm/min og siden dette ikke er en 

standardenhet i DHIs enhetssystem måtte nedbørraten skaleres opp til mm/h. 

Konverteringsverktøyet fra DHI Singapore har ikke en innebygd funksjon for dette, og 

skaleringen ble gjort i MIKE Zero med verktøyet Calculator. Datasettets projeksjon blir heller 

ikke bevart i konverteringen, og må tilegnes på nytt. Dette ble også utført i MIKE Zero. 

Konverteringsverktøyet var dessuten følsomt for inngangsdataenes tidsvariabel. Radaren 

opererer med en offsetverdi der det går med noen sekunder til å sette radaren i posisjon før et 

radarsveip. For 11. juli var konfigurasjonen på radaren slik at offset-verdien var varierende for 

hvert sveip. For å kunne benytte verktøyet måtte alle tidene avrundes til nærmeste minutt. For 

en mer detaljert oversikt over fremgangsmåte henvises det til vedlegg A. Etter bruk av 

konverteringsverktøyet ble nedbørverdiene i dfs2-filen validert mot rasteret generert i ArcMap.  

Fra dfs2-filen i MIKE Zero ble det hentet ut verdier på minuttoppløsning for rutene som dekker 

de syv nedbørstasjonene i tidsperioden 12.30-15.40. Verdiene ble plottet i Excel mot verdiene 

fra nedbørstasjonene for å kunne studere forskjeller i oppbygning, intensitet, varighet og 

mengde. 

3.1.5 Korrigering av værradardata  

Hovedideen ved å korrigere radardata mot bakkemålinger er å kombinere de individuelle 

styrkene i de to målesystemene. Bakkemålinger er punktmålinger som gir relativt høy 

kvantitativ nøyaktighet, og radarmålinger tilfører den manglende romlige fordelingen til 

punktmålingene. Ved å korrigere radardataene mot bakkemålinger kompenserer en for feilen 

og usikkerheten i Z-R relasjonen beskrevet i kapittel 2.3.4. Det finnes flere ulike 

framgangsmåter for å korrigere radardata mot bakkemålinger. Valg av metode avhenger av 

radarnettverket i området, hvordan radardataene er bearbeidet, topografien i analyseområdet 

samt hvor tett nettverket av nedbørmålere er og deres loggertid. Det er tatt utgangspunkt i 

rapporten «Gauge adjustment of radar-based precipitation estimates in Europe» (Gjertsen et. 

al 2004), der det er gitt en oversikt over metodene benyttet ved 21 ulike meteorologiske og 

hydrologiske institutt i Europa. I tillegg er valg av metode diskutert med seniorforsker i NVE, 

Kolbjørn Engeland, som har gjort et tilsvarende studie på et nettverk av nedbørmålere og c-

båndradaren som står på Rissa i Sør-Trøndelag (Abdella & Engeland 2013). 
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Studiets analyseområde har et av de tetteste nettverkene av nedbørmålere i Norge, med om lag 

én nedbørmåler for hver tredje kvadratkilometer, og er satt opp med den hensikt å måle 

ekstreme nedbørhendelser. Korrigeringsfaktoren blir mer stabil jo flere målere det er i området. 

Både tidsoppløsningen på pluviometrene og radaren er ett minutt, og radaren har en romlig 

oppløsning på 250x250 meter. Da avstanden mellom radar og analyseområdet er 38 kilometer 

er det antatt at forskyvingen i tid ikke vil være avgjørende. Samtidig er antall målepunkter på 

bakkenivå totalt sett få, og det er derfor knyttet usikkerhet til det å kunne si noe om den romlige 

korrelerasjonen mellom punktene (Webster & Oliver 1993). For å korrigere dataene er derfor 

MF-korrigering, gitt i ligning 8 i kapittel 2.3.5, benyttet. Metoden gir én korreksjonsfaktor for 

hvert tidsintervall, men er den samme for hele området.  

Korreksjonsfaktoren for de ulike tidsstegene er beregnet for akkumulert nedbør per 10 minutter 

i Excel. Kortere tidsintervall øker usikkerheten i beregningen, mens høyere intervall fører til at 

en mister de hyppige endringene i nedbørhendelsen. Korreksjonsfaktoren er videre multiplisert 

med radardatasettet i MIKE Zero med verktøyet «Calculator» mellom klokken 12.30 og 15.40. 

Dette tilsvarer tidsstegene 750-960 i dfs2-filen. For en mer detaljert oversikt over 

fremgangsmåte for korreksjon av radardata i dfs2-filen henvises det til vedlegg A. 

Det er også beregnet en lokal korreksjonsfaktor for Danvik nedbørstasjon fordi denne er 

beliggende i modellområdet. MF-korrigering er da kun benyttet på datasettet fra pluviometeret 

på Danvik nedbørstasjon. Dette er gjort for å sammenligne mot akkumulert nedbør og 

avrenning fra korreksjonsfaktoren basert på alle stasjonene.  

3.1.6 Gjentaksintervallkart  

Det er produsert gjentaksintervallkart for varigheter på 10 og 40 minutter ved bruk av målte 

verdier på nedbørstasjonene og korrigerte værradardata. For generering av kartene er IVF-

kurven fra Asker nedbørstasjon benyttet. Tidligere nedbørstasjon innenfor analyseområdet, 

Marienlyst nedbørstasjon, har ikke vært i drift siden 1995 og IVF- verdiene for denne stasjonen 

er beregnet for perioden 1963–1995. Siden flere større nedbørhendelser har funnet sted i 

perioden etter målestasjonens opphør er det tatt utgangspunkt i verdiene fra Asker. Dette er 

nærmeste målestasjon med tilfredsstillende måleperiode, og ligger om lag 18,5 kilometer fra 

analyseområdet. Som vist i Figur 3-6 tar IVF-kurven fra Asker utgangspunkt i perioden 1983-

2010. Kurven er hentet fra meteorologisk institutts klimadatabase, Eklima (Meteorologisk 

institutt 2017a). 
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Figur 3-6: IVF-kurve for Asker nedbørstasjon. Verdiene tar utgangspunkt i perioden 1983-2010. Hentet fra Norsk 

Klimaservicesenter (2017a) 

Det er produsert et gjentaksintervallkart basert på målte verdier på nedbørstasjonene for 

hendelsens mest intense 40 minutter mellom klokken 13.40 og 14.20. De målte verdiene er 

interpolert over analyseområdet ved bruk av invers avstandsvektet interpolering (Haberlandt 

2007), der verdiene mellom nedbørstasjonene er beregnet med et avstandsvektet gjennomsnitt 

av de målte verdiene. Interpoleringen er utført med verktøyet IDW (Spatial Analyst) i ArcMap, 

der rutestørrelsen i rasterlaget er satt til 250x250 meter, lik rutestørrelsen i værradardataene. 

Gjentaksintervallkartet fra nedbørstasjonene er videre sammenlignet mot gjentaksintervallkart 

fra korrigert værradardata for de samme 40 minuttene. Det er i tillegg produsert et 

gjentaksintervallkart med varighet på 10 minutter for hendelsens mest intense 10 minutter for 

mellom klokken 14.00 og 14.10. 

Akkumulert nedbør i de korrigerte værradardataene er hentet ut ved bruk av verktøyet Calculate 

Statistics i MIKE Zero. Statistikkfilen er videre bearbeidet i ArcMap som et rasterlag og er 

tilegnet gjentaksintervall fra IVF-kurven. Verktøy benyttet for å lage gjentaksintervallkart for 

korrigerte værradardataene er samlet i Tabell 3-1.  

Tabell 3-1: Anvendte verktøy for produksjon av gjentaksintervallkart. Høyre kolonne beskriver verktøyets funksjon.  

Programvare Verktøy Funksjon 

MIKE Zero Calculate Statistics Henter ut akkumulert nedbør for gitt varighet 

MIKE Zero Toolbox MIKE2GRD Konverterer statistikkfilen (dfs2) til ASCII 

ArcMap ASCII to Raster  Konverterer ASCII til et rasterlag 
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3.2 Nedbørdata fra værradar i avrenningsmodell  

3.2.1 Analyseområde  

For avrenningsmodellen er det valgt et mindre nedbørfelt på 10 km2 i Drammen sentrum. 

Nedbørfeltet drenerer fra Konnerud og Haukås i sørvest ned mot Strømsø bydel. 

Drammenselva er nedbørfeltets utløp. Øvre del av nedbørfeltet er definert som bymark med 

skog og ubebygd terreng mens nedre del av feltet i stor grad er dekket av utbygde flater med 

urban karakter. Feltkarateristika beregnet i Nevina (NVE 2017) gir en urbanprosent på 46% og 

en skogprosent på 39%. Resterende flater er dekket av dyrket mark, mindre bekker og vann. 

Nedbørfeltet for avrenningsmodellen er tidligere benyttet av Johansen og Moldekleiv (2016) 

og Abry (2016). Figur 3-7 viser kart over hele analyseområdet med nedbørfeltet for 

avrenningsmodellen markert. Av nedbørstasjonene beskrevet i kapittel 3.1.3 er det bare Danvik 

nedbørstasjon som er innenfor analyseområdet for avrenningsmodellen. 

 

 

Figur 3-7: Analyseområde for avrenningsmodellen. Nedbørstasjoner er markert som svarte punkter. Illustrasjon laget av 

Kjølseth og Vatne.  
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3.2.2 Nedbørhendelse og nedbørdata 

Det er tatt utgangspunkt i den samme nedbørepisoden som i kapittel 3.1, men kun hendelsens 

mest intense periode mellom klokken 13.40 og 14.20. Det er antatt at evaporasjonen er så liten 

at den kan neglisjeres. I avrenningsmodellen er det kjørt simuleringer med ulik nedbør som 

inngangsdata. Tabell 3-2 gir en oversikt over nedbørdata som er benyttet i simuleringene. 

Førstnevnte nedbørdata i tabellen er oppgavens hovedsimulering, og de resterende er 

simuleringer for sammenligning og diskusjon.   

Tabell 3-2: Oversikt over ulike nedbørdata benyttet i modellkjøringene. 

Nedbørdata Spesifikasjoner  

Radardata med korreksjonsfaktor Korreksjonsfaktor basert på alle nedbørstasjonene 

Radardata med lokal 

korreksjonsfaktor Korreksjonsfaktor basert på Danvik nedbørstasjon 

10-års regnhyetogram Basert på IVF-verdier fra Asker nedbørstasjon 

 

Radardata med lokal korreksjonsfaktor og korreksjonsfaktor fra alle nedbørstasjonene er klar-

gjort for bruk i MIKE 21 Flow Model FM som beskrevet i kapittel 3.1.4, 3.1.5 og vedlegg A.  

Et regnhyetogram med 10-års gjentaksintervall er produsert ved bruk av IVF-kurven fra Asker 

nedbørstasjon gitt i Figur 3-6. Varigheten på regnet tilsvarer nedbørhendelsens mest intense 40 

minutter, og er den samme brukt ved produksjon av gjentaksintervallkart. Valg av 

gjentaksintervall for regnhyetogrammet er basert på majoriteten av rutene i gjentaksintervall-

kartet. Det er valgt et beregningssteg på to minutter som gir 20 intervaller i det symmetriske 

hyetogrammet. Grunnlaget for beregningene er hentet ut direkte fra IVF- kurven i Figur 3-6 og 

ved lineær interpolering mellom punktene. Verdiene er videre regnet om til intensitet i mm/h. 

Ved bruk av formel 2 fra kapittel 2.3.3 er intensiteten i de ulike tidsintervallene beregnet. 

Resultatet er presentert i Tabell 3-3. 
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Tabell 3-3: Beregnet regnintensitet i tidsintervall på fire minutter. Intensiteten er gitt i mm/h.  

Regnintensitetsintervall  Intensitet [mm/h] 

I4 108,7 

I8-I4 71,5 

I12-I8 45,9 

I16-I12 36,5 

I20-I16 34,4 

I24-I20 29,2 

I28-I24 19,1 

I32-I28 17,9 

I36-I32 20,8 

I40-I36 15,3 

 

Regnhyetogrammet ble laget som en tidsserie i en dfs0-fil ved bruk av DHIs brukergrensesnitt 

for pre- og postprosessering, MIKE Zero, med verktøyet Time Series Editor. Hyetogrammet 

ble manuelt lagt inn med samme dato og varighet som den virkelige nedbørepisoden. 

Hyetogrammet ble lagt inn med en hale av 0-verdier som vist i Figur 3-8, for å få med 

avrenningen etter at regnet har opphørt. 

 

Figur 3-8: Konstruert 10-års regnhyetogram fra Asker nedbørstasjon som dfs0-fil. 
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3.2.3 Oppbygging av terrengmodell 

Terrengmodellen er sammen med nedbørdata de viktigste komponentene i avrennings-

modellen. En terrengmodell kan være enten på rasterformat eller triangulert i et mesh som 

forklart i kapittel 2.5.1. I denne oppgaven er sistnevnte metode valgt på bakgrunn av 

muligheten til å benytte lag med ulik romlig oppløsning sammen og at områder med spesiell 

interesse kan tilegnes høyere oppløsning. At lag med ulik romlig oppløsning kan benyttes 

sammen var avgjørende for å kunne bruke data fra værradaren direkte i avrenningsmodellen. 

Klargjøring av data for terrengmodellen er gjort i ArcMap 10.3.1 og oppbygningen er gjort i 

MIKE Zero med verktøyet Mesh Generator. I det følgende er det gitt en beskrivelse av ulike 

verktøy benyttet og en framgangsmåte for oppbygning av terrengmodellen. For en mer detaljert 

oversikt henvises det til vedlegg B.  

Klargjøring av data i ArcMap 

Terrengmodellen tar utgangspunkt i et datasett med terrengpunkter fra laserskanning. 

Datasettet er benyttet i tidligere arbeid og er mottatt av Johansen og Moldekleiv (2016). 

Laserskanningen fant sted den 26. juni 2010 av Terratec på oppdrag for Drammen kommune. 

Datasettet er i LAS-format i koordinatsystemet ETRF1989 med projeksjon UTM32 og 

høydedatum NN1954. LAS-filene ble først konvertert til et LAS-datasett før det ble konvertert 

videre til et raster. Det ble testet med ulike størrelser på rasterrutene. Ruter med størrelse 2x2 

meter ble til slutt valgt som den beste løsningen da lavere oppløsning gav unøyaktig resultat 

og høyere oppløsning gav et tungt og tidkrevende datasett å jobbe med. Rasteret ble klippet til 

nedbørfeltet før det ble konvertert til punkter. Punkter for jernbane- og veibruer som kan 

oppfattes som terreng ble fjernet for ikke å hindre vannstrømmen. I tillegg ble punkter i 

Drammenselva senket til 2 meter under havnivå for å få bedre resultater rent visuelt. Anvendte 

verktøy er samlet i Tabell 3-4.  

Tabell 3-4: Anvendte verktøy ved klargjøring av laserdata til bruk i terrengmodell. Høyre kolonne beskriver verktøyets 

funksjon.  

Programvare   Verktøy Funksjon 

ArcMap Create LAS Dataset (Data Management) Samler LAS-filer i et datasett 

ArcMap LAS Dataset to Raster (Conversion) Konverterer LAS-datasett til raster 

ArcMap Clip (Data Management) Klipper raster 

ArcMap Raster to point (Conversion)  Konverterer raster til punkter 

MIKE Zero 

Toolbox 

Shp2Xyz Konverterer shapefil til griddet 

tekstformat (xyz-format) 
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Bygninger spiller en viktig rolle i vannets strømningsmønster ved flom og må derfor tas hensyn 

til i terrengmodellen. I terrengmodellen er det benyttet et datasett fra felles kartdatabase (FKB) 

med bygninger som inneholder en detaljert beskrivelse av bygningene med tilhørende 

bygningslinjer- og vedheng. FKB-data er på vektorformat og definerer derfor objektene som 

linjer og polygoner. Datasettet er mottatt av Johansen og Moldekleiv (2016) og er i 

koordinatsystemet ETRF89 med projeksjon UTM32 og høydedatum NN2000. Bygningslaget 

kan benyttes sammen med data fra laserskanning uten konvertering av høydedatum da 

bygningslaget senere i prosessen legges inn som polygoner og på den måten ikke tilegnes en 

høyde. Før bygningene ble lagt inn i terrengmodellen, måtte de bearbeides og forenkles. 

Bygningene ble klippet til analyseområdet og bygg som lå på grensen av analyseområdet ble 

klippet bort da disse skapte konflikt senere i prosessen. Alle bygninger med avstand mindre 

enn to meter ble slått sammen. Videre ble bygningsomrissene forenklet. Datasettet hadde i 

tillegg noen geometrifeil som for eksempel at bygninger bestående av flere deler ikke var 

implementert i datasettet i riktig rekkefølge eller at enkelte punkter og polygoner var duplisert. 

Disse feilene ble rettet opp i før datasettet ble klargjort til bruk i MIKE Zero Mesh Generator. 

Bygningslaget ble til slutt klippet i mindre områder innenfor analyseområdet for at det skulle 

være lettest mulig å jobbe med videre i MIKE.  

For å kunne bruke terrengpunktene og bygningene videre i MIKE-programvare ble de 

konvertert til et griddet tekstformat (xyz-fil). Anvendte verktøy for klargjøring av bygnings-

laget er gitt i Tabell 3-5. 

Tabell 3-5: Anvendte verktøy ved klargjøring av FKB-bygningsdata til bruk i terrengmodell. Kolonnen helt til høyre beskriver 

verktøyets funksjon. 

Programvare Verktøy Funksjon 

ArcMap Clip (Analysis) Klipper shapefil   

ArcMap Aggregate Polygons (Spatial Analyst) Slår sammen polygoner innenfor gitt avstand 

ArcMap Simplify buildings (Cartography) 
Forenkler bygninger men beholder fasong 

og størrelse 

ArcMap Integrate (Data Management) 
Sletter sammenfallende punkter og 

polygoner 

Mike Zero 

Toolbox 
Shp2Xyz 

Konverterer shapefil til griddet tekstformat 

(xyz-format) 
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Oppbygging av terrengmodell i MIKE Zero Mesh Generator 

En terrengmodell i form av et flexible mesh består av et nett av små trekanter av valgt størrelse 

som inneholder en verdi interpolert fra relevante inngangsdata. Selve oppbygningen gjøres i 

MIKE Zeros verktøy Mesh Generator. Terrengmodellens utstrekning defineres av åpne og 

lukkede grenser. Formålet med de lukkede grensene er å holde vannet inne i analyseområdet 

mens den åpen grensen lar vannet strømme igjennom. Grensene ble importert som en xyz-fil 

av analyseområdets omriss. Det ble definert en åpen grense langs Drammenselva der det er 

naturlig at regnvannet renner ut, og en lukket grense rundt resten av området som vist i Figur 

3-9. Grensene ble skilt fra hverandre ved at de fikk tildelt ulike attributtverdier. Grenser med 

attributtverdi 1 er lukket mens attributtverdier større enn 1 tilsvarer åpne grenser. Bygninger 

ble lagt inn i terrengmodellen som polygoner med lukkede grenser og er derfor ekskludert fra 

meshet slik at vannet tvinges til å strømme rundt. Polygonene importeres med nøyaktig samme 

størrelse som de har i den opprinnelige filen. Dersom bygningene overlapper, står svært tett 

eller har komplisert form vil ikke meshet kunne genereres. Preprosesseringen som beskrevet 

tidligere er derfor en svært viktig del av oppbygningen.  

 

Figur 3-9: Terrengmodellens utstrekning vist i MIKE Zero-verktøyet Mesh Generator. Åpen grense mot Drammenselva er 

illustrert i rosa og øvrige grenser er lukkede. 
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Meshets oppløsning har en vesentlig betydning for modellens stabilitet og nøyaktighet. Mesh 

Generator gir brukeren mulighet til å spesifisere et maksimalt elementareal for trekantene. Små 

trekanter gir stor nøyaktighet men gir tunge filer med økt beregningstid ved simulering. Store 

trekanter gir unøyaktig resultat men rask beregningstid. Flere verdier ble testet ut og maksimal 

størrelse ble tilslutt satt til 20 m2 på bakgrunn av størrelsen på det totale arealet og ønsket om 

forholdsvis høy nøyaktighet. Verdien faller dessuten innenfor anbefalinger gitt av Engineers 

Australia (2012). For områdene med stor tetthet av bygninger ble det dannet åpne polygoner 

som fikk tilegnet et maksimalt elementareal på 10 m2 på bakgrunn av urbane områders 

innvirkning på avrenning.  

Det ble også angitt en nedre grense for akseptabel størrelse på vinklene i trekantene i meshet. 

Som beskrevet i kapittel 2.5 kan små vinkler gi stabilitetsproblemer ved kjøring. Også her ble 

flere verdier testet med best resultat når minste vinkel ble valgt til 26°. Ved generering må en 

også angi maksimalt antall knutepunkt Ved prøving og feiling ble til slutt 700 000 knutepunkt 

valgt i meshet. Dette gav et mesh med 1 154 378 elementer og 613 201 knutepunkt. Meshet 

kan i etterkant redigeres manuelt og programmet har en innebygd analysefunksjon som angir 

trekanter som kan skape problemer under simulering enten på grunn av sin størrelse eller 

vinkel. Disse trekantene ble flyttet, slått sammen eller fjernet. Til slutt ble det importert 

terrengpunkter klargjort i ArcMap. Punktene ble sammen med meshet interpolert ved bruk av 

interpoleringsmetoden «naturlig nabo», en avstandsvektingsmetode som gir mer nøyaktige 

resultat enn alternativet «lineær interpolering». Terrengmodellen ble så eksportert som en 

mesh-fil. Figur 3-10 viser ferdig terrengmodell og Figur 3-11 et nærbilde av meshet.  
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Figur 3-10: Terrengmodell med bygninger innsatt som polygoner vist i MIKE Zero. 

 

Figur 3-11: Terrengmodellens mesh vist i MIKE Zero. I området med bygninger har trekantene høyere oppløsning enn i 

området rundt. 
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3.2.4 Infiltrasjon 

Infiltrasjon er neglisjert i alle modellkjøringene. Dette er gjort for å begrense usikkerhetene 

knyttet til overflateavrenningen i modellen. Antakelsen kan også sies å være akseptabel da store 

deler av de flate områdene ned mot Drammenselva er svært leirholdige. Grunnvannsstanden 

står dessuten høyt i deler av området, slik at muligheten for å kunne infiltrere større mengder 

overvann er begrenset (Drammen kommune 2015). Den 11. juli 2016 var det også en mindre 

nedbørepisode noen timer før den studerte hendelsen slik at en kan anta at markoverflaten var 

mettet.   

3.2.5 Ruhet 

I alle modellkjøringene er det valgt konstant ruhet med et Manningstall på 14 over hele 

modellområdet. Konstant ruhet ble valgt fremfor romlig varierende ruhet for ikke å tilføre 

modellen større usikkerhet. Valg av Manningstall er basert på erfaringer fra lignende studier 

(Filipova 2012; Johansen & Moldekleiv 2016). Ruhetstallet karakteriseres av modellområdets 

kombinasjon av store skogområder og urbane flater.   

3.2.6 Eddy viskositet  

Siden vanndybden i avrenningsmodeller er forventet å være lavere enn rutestørrelsen i 

terrengmodellen er det valgt konstant Eddy-viskositet basert på resonnementet gitt i kapittel 

2.5.1. Parameteren er valgt til 0.08 m2/s i alle modellkjøringene. Verdien er den samme brukt 

i et liknende studie gjennomført i Sverige (Salmonsson 2015).  

3.2.7 Flood and dry 

Flere verdier ble testet for de bevegelige grensene «flood and dry». For lave verdier gav 

ustabilitetsproblemer under simulering og for høye verdier gav unøyaktige resultat. Det ble tatt 

utgangspunkt i erfaringer fra Salmonsson (2015) der ℎ𝑑𝑟𝑦= 0,002, ℎ𝑓𝑙𝑜𝑜𝑑 = 0,003 og ℎ𝑤𝑒𝑡= 

0,015. Sistnevnte verdi ble justert til 0,01 for å inkludere flere ruter i beregningene tidlig i 

nedbørepisoden for å få større avrenning.  

3.2.8 Simuleringstid 

Simuleringstiden til modellen defineres av starttid, et tidsstegsintervall og antall tidssteg. 

Tidsstegsintervall er en kritisk parameter i forhold til CFL-tallet og dermed stabiliteten og 

nøyaktigheten til modellen. Høyeste tidsstegsintervall som ikke gav stabilitetsproblemer var 

0.2 sekund. Simuleringstiden ble valgt til å være fra klokken 13.40 til 15.40 den 11. juli 2016. 
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Simuleringstiden er lenger enn den mest intense delen av nedbørhendelsen for å få med all 

avrenning etter nedbørhendelsen.  

3.2.9 Modelloppsett 

Modelloppsett refererer til hvordan MIKE 21 Flow Model FM er konfigurert i programmets 

brukergrensesnitt. Komplett oppsett for de tre kjøringene er presentert i de etterfølgende tre 

tabellene. Parametere som ikke er relevant for kjøringene er ikke inkludert.  
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Tabell 3-6: Kjøringsoppsett for kjøring 1 med korrigert nedbør fra alle nedbørstasjoner.  

 

Kjøring 1: Værradardata med korreksjonsfaktor basert på alle nedbørstasjoner 

 

 

 

 

 

 

 

 

 

Hydrodynamic 

Module 

Parameter Value 

Domain Terrengmodell FM 

 

Maximum element area: 20 m2 (10 m2) 

Smallest allowable angle: 26 

Maximum number of nodes: 700 000 

Time No. of time steps: 36 000 

Time step: 0,2 

 

2016-07-11 13.40-2016-07-11 15.40 

Solution Technique Inland flooding 

Time/space: Higher order 

 

Minimum time step: 0,01 

Maximum time step: 0,2 

Critical CFL number: 0,8 

Flood and dry Advanced flood and dry (floodplain) 

 

Drying depth: 0,002 

Flooding depth: 0,003 

Wetting depth: 0,01 

Eddy viscosity Constant eddy formulation: 0.08 m2/s 

Bed resistance Manning number, Constant: 14 m1/3/s 

Precipitation Net precipitation 

Varying in time and space 

 

«Værradardata med korreksjonsfaktor basert på 

alle nedbørstasjoner» 

Infiltration No infiltration 

Boundary conditions Land boundary: Land (zero no velocity) 

Code 2 boundary: Specified level, Constant: 0 

Outputs Output 1: 2D (horizontal)-Area series 

                Time step: 0-36 000 

                Frequency: 300 

- Total water depth, U velocity, V 

velocity, P flux, Q flux, 

Precipitation 

 

Output 2: Inundation 

                 Time step: 0-36 000 

- Maximum water depth, Time of 

maximum water depth, Maximum 

current speed, Time of maximum 

current speed 

Simulation time CPU: 89 hours (4 prosessorer) 

Elapsed: 47,2 hours  
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Tabell 3-7: Kjøringsoppsett for kjøring 2 med lokalkorrigert nedbør fra Danvik nedbørstasjon. 

 

Kjøring 2: Værradardata med lokal korreksjonsfaktor fra Danvik nedbørstasjon 

 

 

 

 

 

 

 

 

 

Hydrodynamic 

Module 

Parameter Value 

Domain Terrengmodell FM 

 

Maximum element area: 20 m2 (10 m2) 

Smallest allowable angle: 26 

Maximum number of nodes: 700000 

Time No. of time steps: 36 000 

Time step: 0,2 

 

2016-07-11 13.40-2016-07-11 15.40 

Solution Technique Inland flooding 

Time/space: Higher order 

 

Minimum time step: 0,01 

Maximum time step: 0,2 

Critical CFL number: 0,8 

Flood and dry Advanced flood and dry (floodplain) 

 

Drying depth: 0,002 

Flooding depth: 0,003 

Wetting depth: 0,01 

Eddy viscosity Constant eddy formulation: 0.08 m2/s 

Bed resistance Manning number, Constant: 14 m1/3/s 

Precipitation Net precipitation 

Varying in time and space 

 

«Værradardata med lokal korreksjonsfaktor fra 

Danvik nedbørstasjon» 

Infiltration No infiltration 

Boundary conditions Land boundary: Land (zero no velocity) 

Code 2 boundary: Specified level, Constant: 0 

Outputs Output 1: 2D (horizontal)-Area series 

                Time step: 0-36 000 

                Frequency: 300 

- Total water depth, U velocity, V 

velocity, P flux, Q flux, 

Precipitation 

 

Output 2: Inundation 

                 Time step: 0-36 000 

- Maximum water depth, Time of 

maximum water depth, Maximum 

current speed, Time of maximum 

current speed 

Simulation time CPU: 76,4 hours (4 prosessorer) 

Elapsed: 40,1 hours  
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Tabell 3-8: Kjøringsoppsett for kjøring 3 med 10-års regnhyetogram fra Asker nedbørstasjon. 

 

Kjøring 3: 10-års regnhyetogram fra Asker nedbørstasjon 

 

 

 

 

 

 

 

 

 

Hydrodynamic 

Module 

Parameter Value 

Domain Terrengmodell FM 

 

Maximum element area: 20 m2 (10 m2) 

Smallest allowable angle: 26 

Maximum number of nodes: 700000 

Time No. of time steps: 36 000 

Time step: 0,2 

 

2016-07-11 13.40-2016-07-11 15.40 

Solution Technique Inland flooding 

Time/space: Higher order 

 

Minimum time step: 0,01 

Maximum time step: 0,2 

Critical CFL number: 0,8 

Flood and dry Advanced flood and dry (floodplain) 

 

Drying depth: 0,002 

Flooding depth: 0,003 

Wetting depth: 0,01 

Eddy viscosity Constant eddy formulation: 0.08 m2/s 

Bed resistance Manning number, Constant: 14 m1/3/s 

Precipitation Net precipitation 

Varying in time and space 

 

«10-års regnhyetogram fra Asker 

nedbørstasjon» 

Infiltration No infiltration 

Boundary conditions Land boundary: Land (zero no velocity) 

Code 2 boundary: Specified level, Constant: 0 

Outputs Output 1: 2D (horizontal)-Area series 

                Time step: 0-36 000 

                Frequency: 300 

- Total water depth, U velocity, V 

velocity, P flux, Q flux, 

Precipitation 

 

Output 2: Inundation 

                 Time step: 0-36 000 

- Maximum water depth, Time of 

maximum water depth, Maximum 

current speed, Time of maximum 

current speed 

Simulation time CPU: 89,6 hours (4 prosessorer) 

Elapsed: 51,4 hours  

 

 



46 

 

3.2.10 PC-spesifikasjoner 

Det ble benyttet tre PC-er til simuleringene. To PC-er er lånt av Norconsult AS og en er lånt 

av DHI AS. 

PC 1   

Operativsystem: Windows 7 64-bit Operating System 

Prosessor: Intel R Core (TM) i7-4800MQ CPU @ 2.70 GHz 

Installert minne: 32 GB 

Harddisk: 936 GB 

GPU: NVIDIA Quadro K2100M 667MHz/3000MHz 

 

PC 2 

Operativsystem: Windows 7 64-bit Operating System 

Prosessor: Intel R Core (TM) i7-4910MQ CPU @ 2.90 GHz 

Installert minne: 32 GB 

Harddisk: 476 GB 

GPU: NVIDIA Quadro K3100M 706 MHz/3200 MHz 

 

PC 3 

Operativsystem: Windows 7 64-bit Operating System 

Prosessor: Intel R Core (TM) i7-3630QM CPU @ 2.40 GHz 

Installert mine: 8 GB 

Harddisk: 465 GB 

GPU: Intel(R) HD Graphics 4000 350-1350 MHz 
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4 Resultater 

4.1 Sammenligning av data fra værradar og nedbørstasjoner 

Det er hentet ut minuttverdier for nedbør fra syv nedbørstasjoner. Verdiene er sammenlignet 

med verdier fra radarruten som dekker nedbørstasjonen. Resultatet er vist i Figur 4-1. 

           

           

            

                                                  

Figur 4-1: Sammenligning av nedbørintensiteter fra syv nedbørstasjoner og tilhørende radarrute for hendelsen i Drammen 

den 11. juli 2016. Lys blå linje viser målt intensitet ved målerne og mørk blå linje viser intensitet fra radarrutene. 
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Tabell 4-1 viser tidspunkt for maksimal intensitet ved stasjonene og avvik fra maksimal 

intensitet i de tilhørende radarrutene. 

Tabell 4-1: Tidspunkt for maksimal nedbørintensitet for syv nedbørstasjoner og tilhørende radarruter for nedbørepisoden den 

11. juli 2016 i tidsperioden 12.30-15.40 i Drammen. 

 

                                        Klokkeslett pluviometer        Klokkeslett radar                  Avvik [min] 

Åssiden 13.35 12.57 -38 

Øren Skole 13.58 13.41 -17 

Sykehus 14.09 14.02 -7 

Tinghus 14.01 13.57 -4 

Bragernes 14.06 13.58 -8 

Danvik 14.02 14.01 -1 

Solumstrand 14.22 14.21 -1 
 

10 minutter akkumulert nedbør fra nedbørstasjonene og tilhørende radarruter er plottet i et 

spredningsplott vist i Figur 4-2. For å finne en sammenheng mellom nedbørdataene fra 

nedbørstasjonene og radaren er det beregnet stigningstall ved bruk av minste kvadraters 

metode, korrelasjonskoeffisient r og determinantkoeffisient r2. Stigningstallet er 0,22, 

korrelasjonskoeffisienten er 0,62 og determinantkoeffisienten er 0,39. Trendlinjen forklarer 

nesten 40 prosent av variansen og kan tolkes som at radarnedbør generelt utgjør om lag 22 

prosent av målt nedbør. Plottet antyder store variasjoner i målingene og en lineær trend er ikke 

representativ på grunn av den store spredningen rund trendlinjen, særlig for de lave verdiene. 

 

Figur 4-2: Spredningsplott av 10 minutter akkumulert nedbør fra syv nedbørstasjoner og tilhørende radarruter i Drammen 

den 11. juli mellom klokken 12.30 og 15.40. 
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4.2 Korreksjonsfaktor 

For hvert 10 minutters intervall i perioden 12.30-15.40 er det beregnet en korreksjonsfaktor 

basert på alle nedbørstasjoner. En korreksjonsfaktor på under 1 antyder at radaren 

overestimerer nedbøren mens en korreksjonsfaktor på over 1 antyder en underestimering. 

Intervallverdier for pluviometer og radar samt korreksjonsfaktor er presentert i Tabell 4-2. 

Tabell 4-2: Summerte verdier fra pluviometer og tilhørende radarrute samt korreksjonsfaktor for 10 minutters intervaller i 

perioden 12.30-15.40 den 11. juli 2016 for syv nedbørstasjoner i Drammen. 

 

Tidsintervall                       Σ Pluviometer [mm]             Σ Radar [mm]                Korreksjonsfaktor 

12.30-12.39 0 0 - 

12.40-12.49 0,2 0,47 0,43 

12.50-12.59 1 4,51 0,22 

13.00-13.09 7,07 6,13 1,15 

13.10-13.19 6,6 3,02 2,19 

13.20-13.29 10,8 3,75 2,88 

13.30-13.39 17,3 5,31 3,26 

13.40-13.49 18,3 9,62 1,90 

13.50-13.59 19,3 18,22 1,06 

14.00-14.09 53,9 15,72 3,43 

14.10-14.19 26,7 6,43 4,15 

14.20-14.29 13,7 2,74 5,00 

14.30-14.39 5,3 1,34 3,96 

14.40-14.49 2 2,33 0,86 

14.50-14.59 3,72 2,86 1,30 

15.00-15.09 4,5 4,18 1,08 

15.10-15.19 5,1 2,83 1,80 

15.20-15.29 2,6 2,49 1,04 

15.30-15.39 2 1,58 1,27 

 

Korreksjonsfaktoren er multiplisert med minuttverdier fra det ukorrigerte radardatasettet. 

Resultatet er fremstilt i Figur 4-3. 
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Figur 4-3: Sammenligning av nedbørintensiteter fra syv nedbørstasjoner i Drammen den 11. juli 2016. Lys blå linje viser 

målte verdier fra pluviometer, mørk blå linje viser verdier fra tilhørende radarrute og oransje linje representerer korrigerte 

radarverdier. 
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For de samme 10 minutters intervallene er det beregnet en lokal korreksjonsfaktor for Danvik 

nedbørstasjon. Summerte verdier fra pluviometer og radar samt de lokale korreksjonsfaktorene 

er presentert i Tabell 4-3. 

Tabell 4-3: Summerte verdier fra pluviometer og tilhørende radarrute samt lokale korreksjonsfaktorer for 10 minutters 

intervaller i perioden 12.30-15.40 den 11. juli 2016 for Danvik nedbørstasjon. 

                                                                                     

Tidsintervall                       Σ Pluviometer [mm]             Σ Radar [mm]          Lokal Korreksjonsfaktor 

12.30-12.39 0 0 - 

12.40-12.49 0 0 - 

12.50-12.59 0 0 - 

13.00-13.09 0 0 - 

13.10-13.19 0 0 - 

13.20-13.29 0 0,04 - 

13.30-13.39 0 0 - 

13.40-13.49 0 1,01 - 

13.50-13.59 0,1 2,57 0,04 

14.00-14.09 4,7 3,58 1,31 

14.10-14.19 4,3 0,92 4,67 

14.20-14.29 1,3 0,14 9,29 

14.30-14.39 0,6 0,13 4,62 

14.40-14.49 0,5 0,65 0,77 

14.50-14.59 0,6 0,35 1,71 

15.00-15.09 1,1 0,85 1,29 

15.10-15.19 1,2 0,58 2,07 

15.20-15.29 0,5 0,44 1,14 

15.30-15.39 0,4 0,22 1,82 

 

De lokale korreksjonsfaktorene for Danvik nedbørstasjon er multiplisert med minuttverdier fra 

det ukorrigerte radardatasettet. Resultatet er fremstilt i Figur 4-4 sammen med 

korreksjonsfaktoren basert på alle nedbørstasjoner, det ukorrigerte radardatasettet og verdiene 

fra pluviometeret.  
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Figur 4-4: Nedbørintensitet ved Danvik nedbørstasjon den 11. juli 2016. 

Totalt akkumulert nedbør for nedbørepisodens mest intense periode er beregnet for Danvik 

nedbørstasjon. Figur 4-5 gir en oversikt over verdier fra pluviometer, ukorrigert, korrigert og 

lokalkorrigert radarverdi for tilhørende rute samt 10-års regnhyetogram basert på det korrigerte 

radardatasettet. Lys blå søyle er målt verdi på stasjonens pluviometer, mørk blå søyle er 

akkumulert verdi i tilhørende radarrute, oransje og grønn søyle er beregnede verdier for 

henholdsvis korrigert og lokalkorrigert radardatasett. Gul søyle viser akkumulert nedbør for et 

10-års regnhyetogram fra Asker nedbørstasjon.  

 

Figur 4-5: Totalt akkumulert nedbør ved Danvik nedbørstasjon den 11. juli 2016 mellom klokken 13.40 og 14.20. 
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4.3 Gjentaksintervallkart  

4.3.1 Gjentaksintervall for 40 minutters varighet basert på nedbørstasjoner 

Tabell 4-4 viser akkumulert nedbør og tilhørende gjentaksintervall på de syv nedbørstasjonene 

i analyseområdet. Gjentaksintervallene er beregnet med utgangspunkt i IVF-kurven fra Asker 

nedbørstasjon for hendelsens mest intense 40 minutter i tidsintervallet 13.40–14.20. Figur 4-6 

viser tilhørende gjentaksintervallkart. Kartet er produsert ved bruk av invers avstandsvektet 

interpolering som forklart i kapittel 3.1.6. 

Tabell 4-4: Gjentaksintervall i nedbørstasjonene med varighet på 40 minutter i tidsintervallet 13.40-14.20. 

 

                                       Varighet [min]            Akkumulert nedbør [mm]         Gjentaksintervall [år] 

Åssiden 40 20,5 2-5 

Øren skole  40 32,3 25 

Sykehus 40 32,1 25 

Tinghus 40 16,2 2-5 

Bragernes 40 8 < 2 

Danvik  40 9.1 < 2 

Solumstrand 40 0 0 

 

 

Figur 4-6: Gjentaksintervallkart for 40 minutters varighet. Kartet er produsert med utgangspunkt i nedbørstasjonene og ved 

bruk av invers avstandsvektet interpolering og gjentaksintervallene i IVF-kurven fra Asker nedbørstasjon. 
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4.3.2 Gjentaksintervall for 40 minutters varighet fra værradardata 

Tabell 4-5 viser akkumulert nedbør og tilhørende gjentaksintervall for de korrigerte 

værradardataene i rutene over nedbørstasjonene. Gjentaksintervallene er beregnet med 

utgangspunkt i IVF-kurven fra Asker nedbørstasjon for nedbørhendelsens mest intense 40 

minutter i tidsintervallet 13.40-14.20. Nederste rad i tabellen viser maksimalt akkumulert 

nedbør på de 40 minuttene og tilhørende gjentaksintervall. Området med høyest akkumulert 

nedbør ligger om lag tre kilometer nord for nedbørstasjonen «Tinghus» med et gjentaks-

intervall på om lag 50 år. Området er markert med rødt i gjentaksintervallkartet i Figur 4-7.  

Tabell 4-5: Gjentaksintervall i korrigert værradardata for 40 minutters varighet. Nederste rad i tabellen viser maksimalt 

akkumulert nedbør og tilhørende gjentaksintervall over analyseområdet.  

 

                                   Varighet [min]         Akkumulert nedbør [mm]              Gjentaksintervall [år] 

Åssiden 40 8 < 2 

Øren skole  40 13,5 < 2 

Sykehus 40 23,5 5- 10 

Tinghus 40 26 10 

Bragernes 40 23,5 5 -10 

Danvik  40 24 5 -10 

Solumstrand 40 0 0 

Maksimale verdi 40 36 50 

 

 

Figur 4-7: Gjentaksintervallkart for 40 minutters varighet. Kartet er produsert med utgangspunkt i korrigerte værradardata 

og gjentaksintervallene i IVF-kurven fra Asker nedbørstasjon. 
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4.3.3 Gjentaksintervall for 10 minutters varighet fra værradardata 

Tabell 4-6 viser akkumulert nedbør og tilhørende gjentaksintervall for de korrigerte 

værradardataene i rutene over nedbørstasjonene. Gjentaksintervallene er beregnet med 

utgangspunkt i IVF-kurven fra Asker nedbørstasjon for nedbørhendelsens mest intense 10 

minutter i tidsintervallet 14.00-14.10. Nederste rad i tabellen viser maksimal akkumulert 

nedbør på gitt varighet og tilhørende gjentaksintervall. Høyeste akkumulerte nedbør tilsvarer 

mer enn et 200-års regn, og er i det samme området som i Figur 4-7. Området er markert med 

rødt i gjentaksintervallkartet i Figur 4-8.  

Tabell 4-6: Gjentaksintervall i korrigerte værradardata med 10 minutters varighet. Siste rad viser maksimalt akkumulert 

nedbør og tilhørende gjentaksintervall over analyseområdet. 

 

                                       Varighet [min]              Akkumulert nedbør [mm]        Gjentaksintervall [år] 

Åssiden 10 3 < 2 

Øren skole  10 5 < 2 

Sykehus 10 7,5 < 2 

Tinghus 10 13,5 10 

Bragernes 10 11 5 

Danvik  10 12 5-10 

Solumstrand 10 0,4 0 

Maksimale verdi 10 22 > 200 

 

 

Figur 4-8: Gjentaksintervallkart for 10 minutters varighet. Kartet er produsert med utgangspunkt i korrigerte værradardata 

og gjentaksintervallene i IVF-kurven fra Asker nedbørstasjon. 
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4.4 Nedbørdata fra værradar i avrenningsmodell 

4.4.1 Nedbøranalyse 

Fra simuleringsresultatene er det hentet ut en tidsserie av nedbøren over modellområdet fra 

kjøringen med korrigert nedbør fra værradar. Figur 4-9 viser tidsserien over nedbørintensiteten 

for hvert minutt mellom klokken 13.40 og 14.20 over analyseområdet. Nedbøren forflytter seg 

i retning sydøst mot Oslofjorden og består av konvektive celler som bygges opp, fusjoneres og 

separeres med stor variasjon i løpet av de 40 minuttene.  
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Figur 4-9: Korrigert nedbørintensitet fra værradar over analyseområdet. Figuren viser intensiteten for hvert minutt, i 

tidsperioden 13.40 – 14.20. 
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4.4.2 Oversvømmelsesanalyse 

Oversvømmelsesanalysene viser oversvømmelsenes utstrekning og dybde. Analysen 

inkluderer alle oversvømmelser som overstiger 0,05 meter. Vanndybdene er visualisert med en 

dybdeklassifisering i ulike blåtoner inndelt i syv klasser fra 0 til 0,6 meter. Mørkere blåfarge 

indikerer dypere oversvømmelse. Alle resultatene som er vist i de etterfølgende figurene er 

hentet ut fra et mindre område rundt Marienlyst idrettspark i Strømsø bydel i Drammen. Det er 

markert seks områder innenfor dette området som er av spesiell interesse. Dette er: 

1) Jernbaneundergangene langs Kreftings gate og Grønland. 

2) Jernbaneovergang i Konnerudgata. 

3) Parkeringskjeller under Marienlyst Stadion. 

4) Parkeringsplass i Doktor Hansteins gate. 

5) Parkeringsplass foran Expert i C. O. Lunds gate 

6) Boligområde i Roseveien 

I presentasjonen av resultatene er det benyttet maksimalverdier av vanndybde. Illustrasjonene 

viser dermed den maksimale vanndybden i hver meshtrekant i løpet av simuleringens varighet.  

Figur 4-10 viser oversvømmelsene fra modellkjøringen med korrigert nedbør fra værradar. En 

ser at undergangene og overgangen knyttet til jernbanen (sirkel 1 og 2) er utsatt for 

oversvømmelse som overstiger 0,6 meter. Det samme gjelder for nedgangen til 

parkeringskjelleren under Marienlyst stadion (sirkel 3). Vanndybder av denne størrelsen gjør 

fremkommelighet umulig og infrastruktur påføres store skader. På parkeringsplassene (sirkel 

4 og 5) er oversvømmelsene større i utbredelse men har lavere dybde. Boligområdet i sirkel 6 

samt et boligområde 400 meter lenger vest er også utsatt for omfattende oversvømmelser.  

Figur 4-11 viser oversvømmelsene fra modellkjøringen med lokalkorrigert nedbør fra Danvik 

nedbørstasjon. Oversvømmelsene i jernbaneundergangene (sirkel 1) er store og overstiger 0,6 

meter. Mindre oversvømmelser oppstår i jernbaneovergangen (sirkel 2) og i 

parkeringskjelleren (sirkel 3). Oversvømmelsene for øvrig består hovedsakelig av små dammer 

i forsenkninger med ubetydelige vanndybder.   

Figur 4-12 viser oversvømmelsene fra modellkjøringen med 10-års regnhyetogram fra Asker 

nedbørstasjon. Oversvømmelsenes utbredelse er som i Figur 4-10 men en ser at vanndybden er 

forskjellig enkelte plasser, som på parkeringsplassen i sirkel 4 der den er større, og for 

overgangen i sirkel 2 og boligområdet i sirkel 6, der den er mindre.  



59 

 

Oversvømmelse- Korrigert nedbør fra værradar 

 

      

Figur 4-10: Oversvømmelseskart fra kjøring med korrigert nedbør fra værradar over et mindre område i Strømsø bydel i 

Drammen. Sirkler er markert rundt områder av spesiell interesse (se tekst for beskrivelse). 
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Oversvømmelse- Lokalkorrigert nedbør fra værradar 

 

      

Figur 4-11: Oversvømmelseskart fra kjøring med lokalkorrigert nedbør fra Danvik nedbørstasjon over et mindre område i 

Strømsø bydel i Drammen. Sirkler er markert rundt områder av spesiell interesse (se tekst for beskrivelse).   
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Oversvømmelsesanalyse 10-års regnhyetogram 

 

      

Figur 4-12: Oversvømmelseskart fra kjøring med 10-års regnhyetogram fra Asker nedbørstasjon over et mindre område i 

Strømsø bydel i Drammen. Sirkler er markert rundt områder av spesiell interesse (se tekst for beskrivelse).  
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4.4.3 Sammenligningsanalyse 

I sammenligningsanalysen er oversvømmelsene ved en kjøring gitt i en helhetlig farge og 

inkluderer alle vanndybder over 0,05 meter. Sammenligningen viser bare oversvømmelsenes 

utstrekning og sier ingenting om oversvømmelsens dybde. Referansekjøringen med korrigert 

nedbør fra værradar er vist i rødt og kjøringene med lokalkorrigert nedbør og 10-års 

regnhyetogram er vist i gult. Overlappende områder er illustrert i blått.  

Figur 4-13 viser sammenligningen av oversvømmelsene fra kjøringene med korrigert nedbør 

og lokalkorrigert nedbør fra værradar. En ser at oversvømmelsene ved kjøring av lokalkorrigert 

nedbør er små sammenlignet med referansekjøringen. Kjøringene har de samme 

oversvømmelsene ved over- og undergangene i tilknytning til jernbanen (sirkel 1) på 

parkeringsplassen i Doktor Hansteins gate (sirkel 2), samt i større deler av boligområdet i 

Roseveien (sirkel 4).  

Figur 4-14 viser sammenligningen av oversvømmelsene fra kjøringene med nedbør fra 

korrigert værradar og 10-års regnhyetogram fra Asker nedbørstasjon. Oversvømmelsenes 

utbredelse sammenfaller i stor grad over det meste av analyseområdet. Oversvømmelsene i 

området rundt kunstgressbanen er størst for kjøringen med korrigert værradarnedbør, mens 

oversvømmelsene i boligområdene (sirkel 3 og 4), samt parkeringsplassen i C.O Lunds gate 

(sirkel 2) er størst for kjøringen med nedbør fra 10-års regnhyetogram.  
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Sammenligningsanalyse- Korrigert og lokalkorrigert nedbør fra værradar 

 

 

     

Figur 4-13: Sammenligning av oversvømmelser fra kjøring med korrigert og lokalkorrigert nedbør fra værradar i et mindre 

område i Strømsø bydel i Drammen. Sirkler er markert rundt områder av spesiell interesse (se tekst for beskrivelse). 
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Sammenligningsanalyse- Korrigert nedbør fra værradar og 10-års regnhyetogram 

 

     

Figur 4-14: Sammenligning av oversvømmelser fra kjøring med korrigert nedbør fra værradar og 10-års regnhyetogram fra 

et mindre område i Strømsø bydel i Drammen. Sirkler er markert rundt områder av spesiell interesse (se tekst for beskrivelse). 
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5 Diskusjon 

5.1 Sammenligning av nedbørdata fra værradar og nedbørstasjoner 

I oppgavens første del sammenlignes data fra nedbørstasjoner og værradar. Det er knyttet 

usikkerhet til både nedbørmålingene fra vippepluviometrene og fra værradaren, men det er 

vurdert at måleusikkerheten til vippepluviometrene for denne hendelsen er neglisjerbar. Dette 

både på grunn av instrumentets oppløsning i tid, med loggertid hvert minutt, og at 

nedbørhendelsen er av konvektiv karakter. For høye nedbørintensiteter anses oppfangersvikten 

og usikkerheten for et vippepluviometer som marginal, og det er derfor tatt utgangspunkt i at 

nedbørdataene fra nedbørstasjonene er den sanne verdi. Ved å studere grafene i Figur 4-1 og 

spredningsplottet i Figur 4-2 i kapittel 4 ser en at radaren underestimerer intensiteten for nesten 

hele perioden når vi sammenligner pikselverdier med tilhørende verdier fra nedbørstasjoner. 

Bare i en liten periode i starten på nedbørepisoden overstiges intensiteten fra værradaren 

nedbørstasjonene. Det er flere grunner til at radaren underestimerer, og det er knyttet størst 

usikkerhet til Z-R relasjonen beskrevet i kapittel 2.3.4. Verdiene for a og b i Z-R relasjonen er 

hentet fra empiriske målinger basert på lange tidsserier. Verdiene treffer godt i snitt, men er 

mer usikre for høye nedbørintensiteter. Det er dermed knyttet usikkerhet til konverteringen av 

radarreflektivitet til nedbørintensitet ved ekstreme nedbørhendelser. I tillegg er det også knyttet 

usikkerhet til signaldemping. I radarbildet fra 11. juli kan en observere nedbør i luftlinjen 

mellom radarens plassering på Helsfyr og analyseområdet i deler av perioden mellom klokken 

12.30 og 15.40. Dette fører til demping av signalet til radaren, og videre til underestimering av 

nedbøren over analyseområdet.  

Ikke-uniform vertikal profil av reflektiviteten er vanligvis en viktig feilkilde ved omgjøring av 

radarreflektivitet til nedbør på bakkenivå. Dette gjelder spesielt for stratiforme systemer som 

består av langstrakte skyer med stor vertikal variasjon. Konvektive nedbørskyer er, i 

motsetning til stratiforme-, svært lokale og forplanter seg hovedsakelig i vertikal retning slik 

at variasjonen i reflektivitet er liten. Da hendelsen i studiet er av konvektiv karakter, samt at 

reflektiviteten er målt 1600 meter over bakkenivå antas det at usikkerheten knyttet til VPR-

korrigeringen er lav.  

Ved å studere grafene i Figur 4-1 og verdiene i Tabell 4-1 i kapittel 4 kan en se at nedbøren 

registreres først i radaren og så i nedbørstasjonene, og at det er en tidsforskyving mellom de to 

grafene. Før sammenligning er det gjort en antagelse om at nedbørdataene fra værradaren og 

nedbørstasjonene er målt i samme tid og rom. I virkeligheten er nedbøren først registrert i 
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radaren før den faller ned på bakkenivå. Dette fører til en tidsforskyving i sammenligningen 

mellom verdiene fra værradaren og nedbørstasjonene. I enkelte studier i litteraturen er dette 

tatt høyde for ved å bruke de omliggende åtte ruteverdiene i tillegg til ruten over 

nedbørstasjonene, enten ved å bruke gjennomsnittet av de ni rutene (Abdella & Engeland 2013; 

Kusiak et al. 2013), eller ved å bruke den ruten som gjør korreksjonsfaktoren minst (Silvestro 

et al. 2008). Ved å gjøre dette antar en at tidsforskyvningen er konstant for alle punkter i 

området. Fra Tabell 4-1, som presenterer avvik mellom pluviometeret og den tilhørende 

radarrutens maksimale verdi, kommer det frem at tidsforskyvningen ikke er konstant. Avviket 

mellom pluviometeret og radarens maksimale verdi varierer fra ett til 38 minutter. Den mest 

banale fremgangsmåten med én ruteverdi er derfor benyttet, dette for å ikke tilføre 

sammenligningen flere usikkerheter og gjøre resultatet mindre robust.   

5.2 Korreksjon av data fra værradar  

På grunn av værradarens tendens til å underestimere nedbør er datasettet korrigert mot 

nedbørmålingene fra nedbørstasjonene. Det ble beregnet en korreksjonsfaktor for et 

tidsintervall på 10 minutter for hele området basert på MF-metoden gitt av formel 8 i kapittel 

2.3.5. Tidsintervallet ble valgt til å være kort nok til å få med de store variasjonene i konvektive 

nedbørhendelser og lang nok til å være stabil. Siden forskjellen mellom data fra værradar og 

nedbørstasjon er størst ved høye intensiteter er også korreksjonsfaktoren størst ved disse 

intensitetene. Korreksjonsfaktorene er listet i Tabell 4-2 og varierer fra 0,33 i et tidsintervall 

tidlig i nedbørepisoden der værradaren overestimerer, til 5,31 om lag midtveis der radaren 

underestimerer mest. Korreksjonsfaktoren ble multiplisert med minuttverdier fra det 

ukorrigerte radardatasettet og resultatet er gitt i Figur 4-3. Generelt kan en se at MF- 

korreksjonen fjernet en signifikant del av underestimeringen. For alle stasjonene med unntak 

av Åssiden kommer intensitetstoppene til samme tid og har samme varighet som for det 

ukorrigerte datasettet. Intensitetstoppene er dog svært høye for enkelte stasjoner, som Danvik 

og Solumstrand som ligger i utkanten av stasjonsnettverket. Dette er en følge av at 

intensitetstoppene ved disse stasjonene sammenfaller med et tidspunkt der korreksjonsfaktoren 

er høy. For disse stasjonene var differansen mellom data fra radar og nedbørstasjon i 

utgangspunktet liten slik at bruk av korreksjonsfaktor utgjør en større overestimering av 

radardataene enn hva de underestimerte i utgangspunktet. For de øvrige stasjonene er 

intensitetstoppene i det korrigerte datasettet bredere og gir mer nedbør på stasjonene. Dette 

forklares med at MF-korrigering gir én felles faktor for hele feltet slik at faktoren er høy over 

en lengre periode som en følge av at intensitetstoppene forskyves i feltet med tid. Det er tydelig 
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at MF-metodens manglende romlige oppløsning gir utslag i datasettet og dette er også 

metodens svakhet.  

For å ta høyde for den romlige variasjonen mellom punktmålingene er det i litteraturen benyttet 

ulike interpoleringsmetoder mellom korreksjonsfaktorene på nedbørstasjonene (Haberlandt 

2007; Krajewski 1987; Lussana et al. 2016; Sinclair & Pegram 2005). Slike metoder kan gi 

bedre prediksjoner men gir samtidig mindre robuste modeller. For at en slik metode skal kunne 

brukes må det foreligge et tilstrekkelig stort tallmateriale til at det kan vises en romlig 

korrelasjon mellom korreksjonsfaktorene. I denne oppgaven er det tatt utgangspunkt i syv 

nedbørstasjoner over en forholdsvis kort tidsperiode og dette utgjør et for spinkelt tallmateriale 

til å kunne trekke generelle konklusjoner (Webster & Oliver 1993). For ikke å tilføre datasettet 

en ekstra usikkerhet som ikke kan gjøres rede for ble derfor den enkleste metoden benyttet.  

Danvik nedbørstasjon ligger innenfor analyseområdet til avrenningsmodellen. På grunn av 

korreksjonsfaktorens store utslag i intensitetstoppene for denne stasjonen ble en lokal 

korreksjonsfaktor også beregnet og testet i avrenningsmodellen. Denne metoden gir mer 

nøyaktige resultater for den aktuelle ruten over nedbørstasjonen, samtidig som usikkerheten 

øker med avstanden fra nedbørstasjonen. Fra Figur 4-4 ser en at de to korrigerte datasettene gir 

store forskjeller i nedbørintensitet. Den høyeste intensitetstoppen fra det korrigerte datasettet 

reduseres betraktelig i det lokalkorrigerte datasettet samtidig som store deler av forregnet kuttes 

da pluviometeret ikke registrerte noe nedbør før 15 minutter etter radaren. Det må understrekes 

at korreksjonsfaktorene benyttet i denne oppgaven er svært usikre og kun er ment som en 

indikasjon for å teste om radardataene er egnet som inngangsdata i avrenningsmodellen.  

5.3 Data fra værradar i avrenningsmodell 

Oppgavens primære målsetning har vært å finne en metodikk for å bruke data fra værradar i en 

todimensjonal hydraulisk avrenningsmodell. Det var ønskelig å finne en metode der rådata fra 

værradaren kunne anvendes direkte med den oppløsningen de var målt. Fra en tidligere 

metodikkoppgave ved NMBU (Johansen & Moldekleiv 2016) er det produsert en avrennings-

modell basert på et terrengraster med oppløsning på 4x4 meter. Siden Helsfyrradaren 

produserte nedbørdata med oppløsning på 250x250 meter, kunne ikke disse lagene benyttes 

sammen i avrenningsmodellen. Problemet ble løst ved at en ny terrengmodell ble bygd i 

ustrukturerte trekanter i MIKE Zero-verktøyet Mesh Generator. Den store fleksibiliteten til 

modellen gir mulighet til å kombinere lag med ulik oppløsning. Salmonsson (2015) har 
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sammenlignet modeller basert på flexible mesh og raster og finner ingen signifikante forskjeller 

i simuleringsresultat.  

Det er kjørt over 40 simuleringer for å komme frem til de tre resultatene presentert i kapittel 4. 

Fra en kjøring til den neste er det testet ulike valg for parametere i kjøringsoppsettet. Dette er 

gjort for å se hvordan valgene påvirker beregningstiden, samt hvor detaljert beregningsnivå 

simuleringene kan ha før programmet får stabilitetsproblemer og terminerer. Ved oppbygging 

av modellen kom det frem at terrengmodellens mesh-oppløsning kan gjøre store utslag, både 

hva gjelder nøyaktighet og simuleringstid. Det ble testet med ulike størrelser på trekantene før 

vi kom frem til en størrelse som gav en tilstrekkelig detaljert terrengbeskrivelse og 

overkommelig beregningstid.  

Ved bruk av nedbør fra værradar er det tidvis svært lite nedbør i analyseområdet. MIKE 21 er 

opprinnelig utviklet for kyst- og havsimuleringer der det er vann i modellområdet til enhver tid 

og de fleste ruter i terrengmodellen er med i beregningene under hele simuleringen. Til 

simulering av urbane flommer med værradardata må en derfor sette de bevegelige grensene 

«flood and dry» tilstrekkelig lavt for å inkludere ruter med lite vann i beregningene. Resultatene 

fra de ulike testsimuleringene viste at små endringer i de bevegelige grensene gav store utslag 

på avrenning i modellen. Valgte verdier for parametere i modelloppsettene i kapittel 3.2.9 var 

de laveste verdiene programmet aksepterte uten å terminere. De bevegelige grensene var også 

parameterne som gav størst utslag på beregningstiden ved simulering. Ved større 

nedbørhendelser antas det at en kan bruke større verdier for de bevegelige grensene og at 

beregningstiden følgelig blir mindre. Tidssteg var en annen parameter med innvirkning på 

modellens beregningstid. En dobling i tidssteg halverte simuleringstiden, men parameteren er 

begrenset til å oppfylle kravet knyttet til CFL-tallet (kapittel 2.5). Parameteren har for øvrig 

ingen innvirkning på detaljnivået i modellresultatene.  

5.3.1 Modellresultater 

Ved bruk av nedbør i en avrenningsmodell er det hovedsakelig mengden nedbør over ett gitt 

tidsrom som gir utslag i avrenning og ikke nødvendigvis størrelsen på øyeblikkintensiteten. 

Figur 4-5 gir en oversikt over totalt akkumulert nedbør fra pluviometeret på Danvik 

nedbørstasjon, radardata i tilhørende radarrute, samt korrigert og lokalkorrigert nedbør og 10- 

års regnhyetogram. En ser at fra Danvik nedbørstasjon er totalt akkumulert nedbør fra det 

korrigerte radardatasettet betydelig større enn fra både det ukorrigerte radardatasettet og 

pluviometeret. Dette skyldes at datasettet er påvirket av intensitetstoppene på alle de syv 



69 

 

nedbørstasjonene slik at toppene er bredere og større og gir mer nedbør enn det opprinnelige 

datasettet. Det lokalkorrigerte datasettet viser derimot, som forventet, samme mengde nedbør 

som målt i vippepluviometeret og nedbørutviklingen er den samme som for det ukorrigerte 

radardatasettet. Det må understrekes at verdiene gitt i Figur 4-5 i teorien kun er gyldige for et 

areal tilsvarende vippepluviometerets oppsamlingsskål, men siden modellområdet bare er på 

10 km2, argumenterer resultatet for at nedbørdataene i det lokalkorrigerte radardatasettet gir 

mer riktige resultat i modellkjøringene sammenlignet med datasettet basert på alle 

nedbørstasjonene. For større modellområder ville muligens det korrigerte datasettet 

representert et bedre estimat. Dersom tallmaterialet hadde vært tilstrekkelig til å påvise romlig 

korrelasjon mellom korreksjonsfaktorene på nedbørstasjonene, ville en metode basert på 

interpolering mellom stasjonene gitt best resultat.  

Resultatet fra Danvik nedbørstasjon gjenspeiles i utbredelsen av oversvømmelser i de ulike 

simuleringene. Modellkjøringen med lokalkorrigert nedbør fra værradaren gir minst 

oversvømmelser, mens kjøringene basert på det korrigerte radardatasettet gav flere og større 

oversvømmelser. Spesielt områdene rundt jernbaneundergangen langs Kreftings gate, 

jernbaneovergangen i Konnerudgata og parkeringskjelleren ved Marienlyst stadion peker seg 

ut som svært utsatt i alle modellkjøringene. Disse områdene var også flomutsatte i studiene til 

Johansen og Moldekleiv (2016) og Abry (2016).  

5.3.2 Avrenningsmodellens usikkerhet 

I samtlige modellkjøringer er det sett bort i fra infiltrasjon. Det vil si at all nedbør vil renne av 

og/eller samles i forsenkninger. Forenklingen er grov, da permeable områder vil kunne 

infiltrere en god del vann avhengig av type løsmasser og løsmassenes tykkelse. Dette kommer 

også frem av et tidligere studie på samme analyseområde (Abry 2016). De lavtliggende 

områdene i området rundt Drammenselva er marine avsetninger og består hovedsakelig av leire 

overdekket av sand og grus. Overdekket forventes å ha god infiltrasjonevne men overdekkets 

dybde gjør at infiltrasjonskapasiteten fylles etter kort tid. I forkant av den valgte 

nedbørhendelsen den 11. juli 2016 var det en mindre nedbørepisode. Ved å anta at denne 

episoden har tatt opp infiltrasjonskapasiteten til løsmassene framstår forenklingen som 

plausibel. Det er også antatt at evaporasjon utgjør en så liten del av nedbøren at den kan 

neglisjeres. Prosessen er også for treg til å gi signifikant effekt. 

Det er også knyttet en usikkerhet til forenklingen av overflatens ruhet. Det ble valgt en konstant 

ruhet over hele området noe som betyr at nedbøren vil strømme med samme hastighet på 
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overflaten uavhengig av underlag. I den virkelige verden forventes det at vannet har høyere 

hastighet på asfalt og andre glatte underlag sammenlignet med gress- og andre 

vegetasjonsdekte arealer. Når vannet bremses forsinkes vannet slik at flomtoppen, og dermed 

oversvømmelsen blir mindre. Abry (2016) kom i sitt studie frem til at overflatens ruhet har 

liten innvirkning på oversvømmelsenes størrelse og omfang. Det antas derfor at denne 

usikkerheten ikke er betydelig.  

Også terrengmodellen er beheftet med usikkerhet. Siden terrenget er helt avgjørende for 

hvordan vannet renner av på overflaten etter en nedbørhendelse, kan feil i terrengmodellen gi 

store utslag i avrenningsmodellen. Laserdatasettet som ble benyttet som grunnlag for terreng-

modellen har høy måletetthet og en måleusikkerhet på +/- 10 centimeter. Det ble produsert et 

punktdatasett fra disse dataene med oppløsning 0,5x0,5 meter slik at en kan forvente at 

måleusikkerheten ikke utgjør store feil. Laserdataene ble målt inn i 2010 og med dagens 

byutvikling kan det tenkes at en ny innmåling ville gitt noen forskjeller i resultat. Fra 

punktdatasettet ble det laget trekanter med størrelse på 10 og 20 m2. Mindre trekanter ville gitt 

en mer nøyaktig beskrivelse av terrenget samtidig som terrengmodellen ville blitt svært 

datakrevende og ført til lange simuleringer og ustabiliteter. På bakgrunn av tidligere analyser 

(Abry 2016; Johansen & Moldekleiv 2016; Salmonsson 2015) og anbefalinger fra Engineers 

Australia (2012) antas det at gjeldende oppløsning er tilstrekkelig.  

Ved bruk av radardata har det ikke vært mulig å ta høyde for ledningsnettets kapasitet. Dette 

tilfører simuleringsresultatene en usikkerhet, spesielt for nedbørepisoder med størrelse 

tilsvarende gjentaksintervallet benyttet i denne oppgaven. Ved bruk av konstruerte regn er 

vanlig prosedyre å trekke fra et gjentaksintervall fra nedbøren som ledningsnettet er 

dimensjonert for. Gammel dimensjoneringsnorm for ledningsnett i Norge var 10 år (TA-550 

1979), slik at all nedbøren som kom den 11. juli 2016 potensielt kunne blitt transportert i 

ledningsnettet. Resultater fra studiet til Johansen og Moldekleiv (2016) tyder på at kapasiteten 

til ledningsnettet i Drammen sentrum har mindre kapasitet enn dimensjoneringsnormen tilsier, 

noe også oversvømmelsene hendelsen medførte tyder på. Ved større nedbørepisoder er det 

akseptabelt å anta at ledningsnettets kapasitet utgjør lite sammenlignet med hendelsens 

omfang. Modellens manglende evne til å inkludere ledningsnettets kapasitet framstår likevel 

som en stor ulempe, men kan løses ved at avrenningsmodellen kobles sammen med en 

hydraulisk ledningsnettmodell i MIKE Flood. Dette vil igjen medføre et betydelig merarbeid i 

etablering av modellen og lengre simuleringstid.  
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Modeller av typen benyttet i denne oppgaven kan i beste fall representere en tilnærming av 

virkeligheten og som det fremgår er avrenningsmodellen i denne oppgaven beheftet med stor 

usikkerhet. Det må understrekes at det ikke er modellresultatene i seg selv som er målet for 

oppgaven, men metodikken bak resultatene. 

5.4 Gjentaksintervallkart  

Vanlig modelleringspraksis i dag er å benytte konstruerte nedbørepisoder fra nedbørstasjoner 

som inngangsdata i modeller. Statistikk basert på nedbørstasjonens tidsserie er bestemmende 

for hendelsens gjentaksintervall og gjentaksintervallet er gjeldende for hele modellområdet.  

Ved sammenligning av gjentaksintervallkartene fra nedbørstasjonene og værradaren (Figur 4-6 

og Figur 4-7) ser en at nedbørstasjonene ikke klarer å fange opp områdene med den mest 

intense nedbøren, og at de dermed underestimerer hendelsens omfang. Tilsvarende funn er også 

gjort i lignende studier (Abdella & Engeland 2013; Lepioufle 2015; Pedersen et al. 2009). 

Nettverket av nedbørmålere i analyseområdet er et av de tetteste i Norge, og det er rimelig å 

tro at underestimeringen er større der nettverket er mer spredt. Gjentaksintervallkartene fra 

værradaren (Figur 4-7 og Figur 4-8) viser også hvor store lokale variasjoner det er i akkumulert 

nedbør og dermed gjentaksintervall innad i analyseområdet. Dette understreker hvor usikkert 

det er å benytte nedbør med det samme gjentaksintervallet over et større modellområde. 

Kartene er produsert med utgangspunkt i IVF-kurven fra Asker nedbør stasjon. Dette gir en 

viss usikkerhet, men formålet med kartene har hovedsakelig vært å diskutere ulikhet i romlig 

oppløsing mellom værradar og interpolerte verdier fra nedbørstasjoner, samt å belyse 

variasjonene i gjentaksintervall innad i analyseområdet. 

Øren skole og Sykehus var de to nedbørstasjonene som registrerte mest nedbør i løpet av 

hendelsen (Figur 4-6). I det tilsvarende kartet fra værradaren (Figur 4-7) ser en at de samme 

nedbørstasjonene er av stasjonene som fikk minst nedbør. Dette gir grunn til å diskutere 

tidsforskyvningen fra nedbøren måles som reflektivitet 1600 meter over bakkenivå til den 

måles på nedbørstasjonene. Det er mulig at en ved å sammenligne radardataene med et 

forskjøvet datasett fra nedbørstasjonene kunne fått et mer samsvarende resultat. Dette er ikke 

studert videre i denne oppgaven.   

5.5 Bruk av værradar til varsling av pluviale flommer 

En værradars hovedfunksjon er å varsle kommende nedbør, til forskjell fra bakkemålinger som 

alltid vil være et verktøy for analyser og statistikk. Ved å benytte sanntidsobservert data fra 



72 

 

værradar i en avrenningsmodell vil en kunne predikere oversvømmelser og pluviale flommer. 

Drift av ledningsnett, renseanlegg og fordrøyningsvolum kan optimaliseres og tilpasses til å ha 

mottaksevne for varslet nedbørmengde.  Det kan iverksettes stenging av veier og tunneler, 

styring av flommen høyere oppe i nedbørfeltet, og settes ut flomdempende tiltak for utsatte 

områder. På den måten kan en redusere skadeomfang og kostnader ved ekstreme 

nedbørhendelser og påfølgende pluviale flommer.  

Underestimering av nedbør i værradaren har vist seg å være signifikant og dataene bør 

korrigeres for før de anvendes i en avrenningsmodell. Korreksjonen mot bakkemålinger kan 

først skje etter at nedbøren har falt på bakken. Kombinasjonen av urbane nedbørsfelts raske 

responstid og konvektiv nedbørs korte varighet kan føre til at flommen allerede har forløpt før 

korrigeringen er gjennomført. Meteorologisk institutt opererer i dag sanntidsvarsling fra 

værradar der mengden nedbør klassifiseres i fem intervaller mellom «lett» og «kraftig». En 

tilsvarende klassifisering for flomvarsling vil kunne være aktuelt da det først og fremst er viktig 

med et varsel på om et område er flomutsatt framfor hvor stor flommen blir. For at et slik 

system skal fungere, må det stilles spørsmål til varslingsnivå. For lav terskel vil føre til 

varslinger uten at flommer oppstår, og for høy terskel vil kunne føre til at store flommer ikke 

varsles. Begge deler vil skape mistillit til systemets pålitelighet. 

For at varsling av pluviale flommer skal kunne bli en realitet kreves et større dekningsnett av 

x-båndradarer. Per i dag eksisterer det kun én mobil x-bånd radar i Norge. Meteorologisk 

institutt drifter et stort nettverket av c-båndradarer, men c-båndradarenes lave oppløsning 

tilfører ytterligere usikkerhet til nedbørdataene i modellen. Dette er tilfellet også utenfor Norge 

og fremstår som en av årsakene til at det eksisterer få operasjonelle pluviale flomvarslings-

systemer (René et al. 2014). 

Når det gjelder avrenningsmodellenes egnethet til varsling av flom er det hovedsakelig 

modellenes beregningstid som er begrensende. Simulering av pluviale flommer er svært 

datakrevende og modellenes kompleksitet er økende. Modellen benyttet i denne oppgaven 

hadde en beregningstid på mellom 47 og 51 timer, noe som ikke er tilstrekkelig til å kunne 

varsle pluviale flommer innenfor en tidsramme som gjør det mulig å iverksette flomdempende 

tiltak. Dersom ledningsnettet inkluderes vil beregningstiden øke. I lys av teknologiutviklingen 

ventes det at dette ikke vil være en begrensende faktor i fremtiden.  
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5.6 Videre arbeid  

Metoden for å korrigere værradardataene i denne oppgaven er enkel og resultatene viser at 

metoden gir opphav til usikkerhet. I videre arbeid anbefales det å benytte data fra flere 

nedbørstasjoner enn det er benyttet i denne oppgaven for å kunne si noe om den romlige 

korrelasjonen i korreksjonsfaktorene. Dersom en romlig korrelasjon kan påvises, kan 

korreksjonsfaktorene interpoleres slik at den romlige variasjonen opprettholdes. Dette kan gi 

mer representative værradardata.  

I denne oppgaven er det ikke tatt hensyn til ledningsnettets kapasitet i simuleringene. Det ville 

derfor vært interessant å se effekten av å koble avrenningsmodellen sammen med en hydraulisk 

ledningsnettmodell over det samme analyseområdet.  

Utviklingen innenfor radarteknologi, modellering og datakapasitet er stor. Det anbefales derfor 

at det jobbes videre med problemstillingen slik at værradar kan benyttes til varsling av pluviale 

flommer i fremtiden. 
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6 Konklusjon 

Det er utarbeidet en metodikk for å anvende nedbørdata fra værradar i en todimensjonal 

hydraulisk avrenningsmodell. Ved å benytte en terrengmodell basert på ustrukturerte trekanter 

kunne dataene fra værradaren anvendes direkte på den oppløsningen i tid og rom de var målt.  

For å studere værradardatas egnethet i en avrenningsmodell er nedbørdata fra værradar og 

nedbørstasjoner sammenlignet for en nedbørhendelse av konvektiv karakter. Resultatene viser 

at værradaren underestimerer nedbøren for alle intensiteter, og at feilen er økende med økt 

intensitet. Underestimeringen skyldes feil ved konvertering av målt radarreflektivitet til 

nedbør, og gjør nedbørdata fra værradar på sin opprinnelige form mindre egnet som 

inngangsdata i avrenningsmodeller.  

For å bedre den kvantitative kvaliteten til værradaren er nedbørdataene korrigert mot 

nedbørstasjonene på bakkenivå. I simuleringene er det testet ut to ulike korrigerte datasett, der 

ett er korrigert mot syv nedbørstasjoner som alle er innenfor tre kilometer fra modellområdet, 

og ett er korrigert mot én nedbørstasjon innenfor modellområdet. Resultater fra simuleringene 

viser at valg av korreksjonsmetode har stor innvirkning på avrenningen. Det lokalkorrigerte 

datasettet får betydelig mindre avrenning som en følge av at datasettet beholder nedbørens 

opprinnelige utvikling på nedbørstasjonen. Det ble også kjørt en simulering ved bruk av et 

regnhyetogram med samme intensitet som det korrigerte datasettet. Resultatene fra denne 

sammenligningen viste ingen nevneverdige ulikheter.  

Det er produsert gjentaksintervallkart basert på målte verdier på nedbørstasjonene og korrigerte 

værradardata. Sammenligning av kartene viser at det interpolerte kartet fra nedbørstasjonene 

ikke fanger opp de mest intensive og nedbørrike områdene for hendelsen og dermed 

underestimerer det høyeste gjentaksintervallet i analyseområdet. Kartene viser også verdien av 

den romlige oppløsningen en værradar kan tilføre avrenningsmodellen.  

For at værradardata skal benyttes i avrenningsmodeller som et verktøy for å varsle pluviale 

flommer må den kvantitative kvaliteten til nedbørdataene forbedres. I tillegg må 

simuleringstiden reduseres til en tid som gjør det mulig å iverksette flomdempende tiltak.  
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Vedlegg A: Konvertering av radardata fra NetCDF til dfs2 

Radardataene lastes ned fra Meteorologisk institutts database Thredds (http://thredds.met.no) 

på filformatet NetCDF. Dataene dekker en sirkel med radius på 50 km, med radarens 

plassering på Helsfyr som sirkelens sentrum. Dette datasettet har projeksjonen WGS84 UTM 

32, tidsoppløsning på ett minutt og varighet på et døgn. 

For å anvende radardataene som input i MIKE må de konverters til dfs2-filer. Konverteringen 

gjøres i et verktøy utviklet av DHI Singapore. Verktøyet er ikke utviklet for konvertering av 

radardata på gitt format, men kan anvendes med noe etterarbeid. Verktøyet krever lisens fra 

DHI. 

 

A-1  Åpne konverteringsverktøy 

Åpne verktøyet NetCDF/Grib2 To DFS Format Conversion og legg inn informasjonen 

som vist i figur under. Velg «extract». 

Verktøyet lager en dfs2-fil som lagres i samme mappe som input-filen ligger i.  

 

A-2   Definere projeksjon 

Radardataene i NetCDF-filen er på et rasterformat med 250x250 meters oppløsning i 

koordinatsystemet WGS 84 UTM 32. Datasettets projeksjon blir ikke bevart i 

konverteringen og må tilegnes på nytt.  

Edit> Geographical Information> Type> Browse> WGS 84 UTM 32. 

I «Synchronize Coordinates», velg alternativet «Keep geographical Coordinates and 

derive Map Projection Coordinates». Sett inn verdier for «Easting» og «Nothing» fra 

metadata i NetCDF-filen som vist i figur under. 

http://thredds.met.no/


ii 

 

 

 

Etter projeksjonen er lagt til skal «grid spacing» ha endret seg fra 250 degree til 250 

meter som vist i figurene under. 
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A-3    Skalering av datasett; Enhet 

Verdiene i NetCDF-filen har nedbørsrate med enhet mm/min. MIKE ønsker 

nedbørinput med enhet mm/h og verdiene må derfor skaleres. Konverteringsverktøyet 

benyttet i punkt 1 endrer ikke verdiene og fremstillingen med skalaen i figurene over er 

feil. Skaleringen fra mm/min til mm/h gjøres i «Tools» i dfs2-filen.  

Tools> Calculator> Expression «s=s*60», som vist i figuren under. 

I fanen «Sub-Set» velges hele rutenettet og alle tidsstegene. 

    

 Som vist i figuren under er nå minuttverdiene skalert opp til enheten mm/h.  
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A-4    Skalering av datasett; Korreksjonsfaktor 

For å skalere værradardataene i dfs2-filen mot nedbørstasjonene brukes også 

kalkulatoren i MIKE Zero. Korreksjonsfaktoren for dette datasettet er beregnet for 

akkumulert nedbør per. 10. minutter fra kl. 12:30 til 15:40, som tilsvarer tidsstegene i 

intervallet 750 – 940.   

Tools> Calculator> Expression «s=s*x», der x er korreksjonsfaktoren for gjeldene 

tidssteg. Som vist i figuren under, velg alle ruter og velg intervallet for tidssteg.  
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Vedlegg B: Oppbygging av terrengmodell FM 

Terrengmodell bygges opp i MIKE Zero Mesh Generator. Relevante datasett må klargjøres i 

ArcMap eller annen programvare for stedfestet data. Nødvendig data til oppbygging av 

terrengmodell brukt i denne oppgaven er 

o Terrengpunkter: LiDAR-data 21.06.2010 

o Bygningsinformasjon: FKB-data 

o Veiinformasjon: FKB-data 

o Omriss av analyseområdet: Shapefil 

 

B-1 Klargjøring av terrengdata 

B-1.1 Legge inn laserskannet data 

Åpne ArcMap og søk opp ArcToolbox: Create LAS Dataset (Data Management). Velg 

ønskede LAS-filer som vist i figur under og velg «ok». Søk opp ArcToolbox: LAS 

Dataset to Raster (Conversion). Under «Sampling type» velges rutestørrelse med 

ønsket verdi og «ok».  

                                      

 

B-1.2 Klippe analyseområde 

For å klippe ut ønsket område velges ArcToolbox: Clip (Data Management). Under 

«Output extent» legges shapefil av analyseområdet inn. Huk også av «Use Input 

Features for Clipping Geometry».  
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B-1.3 Lage punktverdier 

For å gjøre om rasteret til punktverdier brukes ArcToolbox: Raster to Point 

(Conversion). Verktøyet produserer punkter sentrert i rasterrutene slik at avstanden 

mellom dem vil være like stor som valgt rutestørrelse over. 

 

B-1.4 Fjerne bruer 

Jernbane- og veibruer kan føre til at vannet akkumuleres i områder det normalt 

strømmer forbi på grunn av høydeforskjeller. Terrengpunktene for disse områdene må 

derfor fjernes.  

Åpne FKB-veier> Åpne attributtabell> Select by attributes> Skriv inn koden: 

«(Medium = ‘L’) AND NOT OBJECTID = 6330 AND NOT OBJECTID = 6331»> 

Verify. 

Høyreklikk på FKB-vei i innholdsfortegnelsen> Create Layer from Selected Features- 

kall dette laget «bruer»> Select (fane)> Select by location> Velg innstillinger som vist i 

figur under.  
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Punktene som nå er valgt er terrengpunkter for bruer. På grunn av usikkerhet i 

laserdatasettet ble det valgt punkter innenfor en distanse på 2,5 meter fra brulaget. De 

valgte punktene slettes fra datasettet(Editor> Start editing> Delete selected). For bruene 

som er bredere enn 2,5 meter må punktene mellom ytterkantene manuelt fjernes ved 

bruk av «Select Features by Polygon». Det anbefales å gjøre en kontroll rundt bruene. 

Hvis ikke alle de høye verdiene er fjernet må prosedyren gjentas med en større verdi 

eller endres manuelt.  

 

B-1.5 Senke vannivå i elv 

Terrengpunkter i elven senkes til 2 meter under havoverflaten. Dette fordi enkelte 

punkter i elva har høye verdier i forhold til punktene rundt selv etter at bruene var 

fjernet. Senkningen har ingen virkning for avrenningen men gir et penere resultat 

visuelt. Det ble lastet inn en shapefil av elva og punktene ble valgt manuelt ved bruk av 

«Select Features by Polygon».  

Editor> Start Editing> Høyreklikk på valgte punkter> Attributes> Marker alle punkter 

og endre «Grid_Code» til -2.  

 

 

B-1.6 Konvertering til xyz-format 

For å kunne åpne punktverdiene i MIKE-programvare må dataene være på xyz-format. 

Denne konverteringen gjøres i MIKE Zero Toolbox.  

Åpne MIKE Zero> File> New file> MIKE Zero Toolbox> GIS> Shp2Xyz> Under «z- 

value» skrives kolonneverdien som inneholder z-verdien inn.  
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B-2 Klargjøring av bygningsdata 

B-2.1 Klippe bygningslag 

Åpne shapefil av bygninger fra FKB og polygon av analyseområdet i ArcMap. Velg 

ArcToolbox: Clip (Analysis) for å klippe bygningene til det angitte analyseområdet.  

I dette tilfellet er det hensiktsmessig å dele bygningene inn i seks mindre områder før 

innlasting i MIKE for å lettere identifisere eventuelle feil. Inndelingen utføres ved 

opptegning av polygoner som brukes som «Clip feature» som vist i figur under. 

Bygninger som ligger på grensen til analyseområdet klippes bort. 

 

B-2.2 Forenkling av bygningslag 

Bygningene må forenkles og slåes sammen før de kan brukes i Mesh Generator.  

ArcToolbox-verktøyet Simplify Buildings (Cartography) forenkler polygonenes grenser 

men beholder deres hovedfasong og størrelse. Det er valgt en toleransegrense 0,5 for 

denne forenklingen som vist i figur under. 

Verktøyet Aggregate Polygons (Cartography) slår sammen bygninger med avstand 

mindre enn en gitt verdi. Denne avstanden ble valgt til 2 meter som vist i figur under.  

Verktøyet Integrate (Data Management) fjerner dupliserte punkter og polygoner.  
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B-2.3 Konvertering til xyz-format 

Bygningene må gjøres om til xyz-format for å kunne åpnes i MIKE-programvare. Dette 

gjøres som i punkt B-1.6, men «polygon» velges fremfor «points». Det samme gjøres 

med shapefilen av omrisset.  
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B-3 Oppbygging av terrengmodell i MIKE Zero Mesh Generator 
B-3.1 Åpne program 

Åpne MIKE Zero> File> New File> Mesh Generator.mdf.  

Velg geografisk projeksjon «ETRS_1989_UTN_Zone_32N».  

 

B-3.2 Legge inn grenser 

For å angi utstrekningen til analyseområdet hentes det inn omriss av analyseområdet på 

xyz-format.  

Data> Import boundary> Åpne xyz-filen og velg å legge til hele området som en «arc» 

som vist i figuren under. 

 

B-3.3 Definere grenser 

Omrisset rundt analyseområdet er nå en polylinje med mange knekkpunkter som 

representerer en lukket grense. For at vannet skal kunne renne ut i elven må linjen som 

ligger langs elven defineres som en åpen grense.  

Dette gjøres ved at en endrer knekkpunktene på hver side av linjen som knutepunkter. 

Knutepunkter og mellomliggende linjer defineres med et heltall som brukes i 

modellsystemet til å skille mellom åpne og lukkede grenser. Heltall større enn 1 

tilsvarer åpne grenser og 1 tilsvarer lukkede grenser. Det ytterste knekkpunktet i linja 

en øønsker som åpen grense velges. 

Høyreklikk på knekkpunktet> Vertices to nodes> Høyreklikk på knekkpunktet> 

Properties> Velg a>1. Det samme gjøres for det andre ytterpunktet og linja imellom. 
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B-3.4 Forenkle grenser 

Enkelte linjer er lagt inn med mange knekkpunkter og unødvendig høy nøyaktighet. 

Dette vil føre til at meshet som senere skal genereres får små vinkler slik at 

terrengmodellen blir tung å kjøre i simulering. Knekkpunktene kan fjernes manuelt ved 

bruk av «delete points» på verktøylinjen. Bare punkter som ikke endrer formen på 

omrisset kan fjernes (150-200 punkter).  

B-3.5 Legge inn bygninger 

Bygninger legges også inn som grenser. Ved å la disse være lukkede, er bygningene 

polygoner som vannet tvinges til å strømme rundt. Fra punkt x er det klargjort seks 

mindre utklipp av bygningslaget i ArcMap. Disse hentes inn hver for seg da det er 

lettere å se hvor eventuelle feil ligger.  

Data> Import boundary> Velg innstillinger som vist under.  

 

Med bygningslaget skal vinduet se slik ut: 

 

B-3.6 Definere polygoner 

Områder med stor betydning for avrenningen defineres ved at det tegnes en lukket linje 

rundt (draw arc) med et polygonpunkt innsatt i midten (insert polygons).  

Høyretrykk på polygonet> Properties> Huk av følgende innstillinger. 
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Maksimal trekantstørrelse er i dette polygonet valgt til 10 m2. Dette punktet gjentas for 

alle områder en ønsker høyere oppløsning.  

B-3.7 Generere Mesh 

Mesh generatoren lar brukeren velge maksimalt elementareal for analyseområdet 

utenom de egendefinerte polygonene, minste vinkel på trekantene og antall knutepunkt 

i meshet.  

Mesh> Generate mesh> Velg innstillinger som vist under. 

 

 

Det kan være lurt å opprette og slette mesh under hele prosessen for å teste at alt er som 

det skal da programmet ikke gir spesifikke feilmeldinger. Selve meshgenereringen kan 

være et problem hvis en ikke lagrer jevnlig underveis. En løsning som ofte fungerer er å 

avslutte programmet, åpne på nytt og prøve på det samme.  
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B-3.8 Innhenting av topografisk data 

Data> Manage scatter data> Add xyz file> Velg punktverdier på xyz- format> Apply 

 

Med topografisk informasjon skal vinduet se slik ut:

 

B-3.9 Manuell justering av mesh 

Små trekanter og vinkler gjør terrengmodellen tung å kjøre i simuleringer. En ønsker 

derfor å forbedre det så mye som mulig. Dette kan gjøres manuelt i Mesh Generator. 

Mesh> Mesh editing> Mesh> Analyse mesh 
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Analysen gir en oversikt over de minste elementarealene og vinklene i meshet. Det er 

også mulig å zoome direkte til disse områdene hvor en kan velge å endre størrelse og 

form på vinklene (move mesh node) eller slette trekantene (collapse element). 

Endringene gjelder kun for det genererte meshet og hvis det genereres et nytt mesh må 

endringene gjøres på nytt.  

 

B-3.10 Interpolering 

Når topografiske data er hentet inn må verdiene interpoleres for at trekantene skal få en 

verdi.  

Mesh> Interpolate> Velg instillinger som vist under.  

 

 

B-3.11 Eksportering av mesh 

Terrengmodellen eksporteres som en mesh-fil og er klar til bruk i avrenningsmodell. 

Mesh> Export mesh. 
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